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The purpose of this survey is to provide contemporary surveys to update National Ocean Service (NOS) nautical 
charts. All separates are filed with the hydrographic data. Any revisions to the Descriptive Report (DR) generated 
during office processing are shown in bold red italic text. The processing branch maintains the DR as a field unit 
product, therefore, all information and recommendations within the body of the DR are considered preliminary 
unless otherwise noted. The final disposition of surveyed features is represented in the OCS nautical chart update 
products. All pertinent records for this survey, including the DR, are archived at the National Geophysical Data 
Center (NGDC) and can be retrieved via http://www.ngdc.noaa.gov/. 
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A. AREA SURVEYED

A1. Introduction

This Descriptive Report documents a hydrographic survey conducted in the Fort Point 
vicinity of Portsmouth Harbor, New Castle, NH.  The data were acquired to fulfill the 
requirements of the University of New Hampshire Center for Coastal and Ocean
Mapping – Joint Hydrographic Center 2007 Summer Hydrographic Field Course.  The 
hydrographic data were acquired with a Kongsberg EM3002D dual-head multibeam
echo-sounding (MBES) system bow-mounted on the R/V COASTAL SURVEYOR.

A2. Project Description

The major objective was to repeat a hydrographic survey of a large sand shoal in
Portsmouth Harbor, NH multiple times over the two-week survey period.  Five high-
resolution multibeam echosounder (MBES) datasets were acquired over a spring-neap
cycle to identify changes in bedform morphology in the survey area for the purposes of 
better understanding tidal controls on coarse-grained sediment transport in the lower 
Great Bay Estuary (GBE).  A second objective of the hydrographic survey was to obtain
a 100% coverage surface of the survey area for the purposes of updating the existing 
National Oceanic and Atmospheric Administration (NOAA) nautical chart 13283 (Cape 
Neddick Harbor to Isles of Shoals).

Requirements for the survey exceed IHO Special Order specifications for depth and 
position accuracy.  Successful completion of the project entails resolving and locating,
with decimeter-level accuracy, sand waves with minimum amplitude of at least 0.2 m and 
minimum wavelength of at least 4 m.

A3.  Survey Area

The survey area was located in Portsmouth Harbor immediately south of Fort Point, New 
Castle, NH (Figure 1).  The survey area was bounded to the west by New Castle, NH, and 
to the east by Gerrish Island, ME. A previous survey of this area conducted by NOAA
Ship WHITING in November, 2000 indicates that the area is dominated by a large (0.14
km2) shoal bounded by flat bottom to the west and rocky bottom to the east.

The MBES data were acquired on June 8 and 14-15, 2007 (Day Numbers 159 and 165-
166). Each of the five hydrographic surveys included, on average, 4.8 linear nm of 
multibeam sounding lines at 19 m line spacing and 0.35 linear nm of crosslines.  The 
entire survey area encompassed 0.17 km2.  A total of 23.94 linear nm of sounding lines
from the survey area was acquired for the project.
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Figure 1 Chartlet of survey area with approximate extent of survey coverage (taken from Survey #2).
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B.  DATA ACQUISITION AND PROCESSING

B1. Equipment

1.0  Survey Vessel

1.1 Vessel Specifications

R/V COASTAL SURVEYOR is a 12.2-meter subchapter "C" research vessel built
specifically for coastal hydrography (Figure 2).  Propelled by a single-screw diesel 
engine and roll-stabilized with Niad active fins, R/V COASTAL SURVEYOR is capable 
of survey speeds ranging from 2.5 to 10 knots, although a minimum speed of 5 knots is 
required for full effective roll stabilization.  The vessel is equipped with a motor-driven
bow ram, the base of which is used to mount a variety of sonar systems.

Figure 2 Acquisition Platform. Data were acquired with systems aboard R/V COASTAL SURVEYOR 
(source:  http://ccom.unh.edu).

2.0  Hardware

2.1 Hardware Systems Inventory

Table 1 summarizes the major hardware components used during the survey.  A
generalized schematic of the survey system is shown in Figure 3, and the major
communication ports are detailed in Table 2.
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Table 1 Hardware systems inventory.
Equipment Manufacturer Model Serial Number

Vertical Control
Water Level Gauge Aanderaa 3791 47
Optical Level Keuffel & Esser Co. - JHC00165

Horizontal Control
RTK Base Station
Receiver Trimble 5700 CORS 2203582930

RTK Base Station 
Radio Modem Trimble Trimmark3 456152537
RTK Rover Radio
Modem Trimble Trimmark3 4526152531
WAAS DGPS Rx C&C Technologies C-Nav 787004
VHF DGPS Rx Trimble DSM212H 0220261281
Laptop Dell - 29360279953

Sound Speed
Surface Velocimeter Odom Digibar Pro 9800 98139
Sound Speed Profiler Applied Microsystems SV Plus 3319

Positioning, Heading, & Attitude System
PCS Applanix - 2171
IMU Applanix - 179
Primary Rx Trimble BD950 4452A44285
Secondary Rx Trimble BD950 4447A44091

Echo Sounding
Port/Starboard
Transducers Kongsberg EM 3002D 322/481

SIS Computer Kongsberg EA400 230
Processing Unit (PU) Kongsberg EM 3002 1014
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Figure 3 Survey system schematic.

Table 2 Port Configuration.

Not used
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2.2 Vertical Control Equipment

Vertical control equipment used during the survey is discussed in detail in Section C1
(Vertical Control) and in the Tide and Water Levels report included in Appendix IV.

2.3 Horizontal Control Equipment

Horizontal control equipment used during the survey is discussed in detail in Section C2
(Horizontal Control).

2.4 Sound Velocity Equipment

Two sound-speed devices were used during the survey:  an Odom Digibar Pro
velocimeter and an Applied Microsystems SV Plus sound velocity profiler

2.4.1 Odom Digibar Pro 9800

Mounted on the top of the port side of the multibeam sonar transducer mount, the Odom 
Digibar Pro was used to measure the speed of sound required for beam steering at the 
face of the two multibeam transducers.

2.4.2 Applied Microsystems SV Plus Sound Velocity Profiler

Water-column sound “velocity” (i.e., speed) data were acquired with an Applied
Microsystems SV Plus sound velocity profiler.  The program SmartTalk was used to 
configure the SV Plus prior to each cast and to download the data after each cast.

2.5 Positioning, Heading and Attitude Equipment

Position, heading, and attitude data were acquired with an Applanix POS/MV, version 4, 
operating in RTK GPS mode.  Discussed further in Section C2 (Horizontal Control), the 
RTK correctors were received by a Trimble Trimmark3 radio modem.  A C&C
Technologies C-Nav WAAS receiver was configured to serve as a secondary source of 
differential correctors in the event of RTK outages.  The vessel was also equipped with a 
Trimble DSM212H receiver to receive differential correctors in the event of C-Nav
outages; however, the DSM212H was never used.

2.6 Echo Sounding Equipment

MBES data were acquired with a Kongsberg EM 3002D, a 300-kHz dual-head system 
with the port and starboard transducers mounted at 40° and -40° angles, respectively (in a 
right-handed coordinate system).  Each transducer forms 160 beams, with up to 255 
sounding solutions per ping.  The along- and across-track beamwidth of each broadside 
beam is 1.5°.
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2.7 Manual Sounding Equipment

No manual sounding equipment was used during the survey.

3.0  Software

3.1 Software Systems Inventory

Software used during the survey is summarized in Table 3.

Table 3 Software systems inventory.
Software Version Purpose

Acquisition
SIS 3.4.1 MBES data display & logging
Smart Talk 2.25 SV Plus configuration/downloading
Hypack 4.3a Navigation/line steering
POS/MV Controller 3.1.0.1 (build 23) POS/MV configuration & data logging

Processing
CARIS HIPS & SIPS 6.1 HF13 MBES data processing
CARIS BASE Editor 2.0 Surface differencing
Pydro 7.3 (r2110) Feature management & cross line analysis

3.2 Data Acquisition Software

Kongsberg’s Seafloor Information System (SIS) was used for the display and logging of 
the EM 3002D data.  The sonar was operated in manual equiangular mode, with the 
port/starboard coverage of the port and starboard transducers defined to be 50°/15° and 
15°/50°, respectively.  Whereas the primary antenna-to-IMU lever arm was accounted for 
in the POS/MV controller, the IMU-to-transducer lever arm was entered into the
installation parameters of SIS.  A comprehensive report of the SIS installation and 
runtime parameters is included in Appendix V.

Smart Talk was used to configure the SV Plus prior to a cast and to download SVP data 
after a cast.  A Kongsberg script, csv2asvp.bat, was used to convert the comma-delimited
file produced by Smart Talk into the *.asvp  format required by SIS for real- time sound 
speed correction.

Hypack was used only to provide line-steering navigation.  No Hypack data were
acquired.
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The POS/MV controller software (MV-POSView) was used to configure the POS/MV 
communication ports and to control Ethernet data logging.  Sixteen data groups were 
enabled in Ethernet logging (Table 4).  The only lever arm entered in the POS/MV 
configuration was the primary antenna-to-IMU lever arm.  The reference point is the
IMU, which is assumed to be located at the center of gravity.

Table 4 Ethernet logging groups.
Group Description

1 Navigation solution
2 Performance metrics
4 IMU data
5 Event 1
9 GAMS solution
10 General status and fault detection
99 Version and statistics
110 MV general status
111 Heave data
112 NMEA strings
113 Heave data quality control
10001 Primary GPS data stream
10006 Raw DMI data stream
10009 Secondary GPS data stream
10011 Raw differential corrections 1
10012 Raw differential corrections 2

3.3 Data Processing Software

CARIS HIPS 6.1 was used to process the EM 3002D MBES data.  Because the depth 
datagram that is read into CARIS is already corrected for sound speed, attitude, water 
level, and the transducer lever arm, the only correctors applied in post processing are the 
patch test correctors and the dynamic draft correctors.  The option exists in CARIS to re-
apply a sound speed cast to EM data, but this option was not used because (1) the data do 
not show any significant sound speed or refraction artifacts, and (2) the exact nature of 
the algorithm used by CARIS was not well-understood by the post-processing personnel.
A report detailing the configuration of the HIPS vessel configuration file (HVF) is 
included in Appendix V.

4.0  Personnel Inventory

An inventory of all survey personnel is summarized in Table 5.
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Table 5 Survey personnel inventory.
Captain

Ben Smith
Mate/Deck Hand

Bridget Kelley
Instructor

Capt. Andrew Armstrong
Survey Personnel

Janice Felzenberg
Nicholas Forfinski
Vasudev Mahale
Nguyen Thanh

B2.  Quality Control

1.0  Procedures

1.1 Survey Planning

Survey planning consisted of determining a uniform line spacing, survey speed, and 
swath coverage that would ensure the realization of the requirements outlined in Section 
A2 (Project Description).  A simplified EM3002D beam footprint model (included in 
Appendix V) was developed in Excel to aid in survey planning.  The model calculates the 
across- and along-track dimension of each beam, assuming a flat bottom and equiangular 
mode and given a water depth and a swath width defined by angles to either side of nadir.

A major constraint in planning the survey was the duration of the maximum-current
window within which each survey was to be executed.  Although the ideal goal was to 
have a small line spacing dictated by the resolving capabilities of the smallest footprint in 
the deepest part of the survey area, the need to survey the area in 1.5 hours while going as 
slow as possible while maintaining steering capabilities necessitated increasing the line 
spacing. The combination of a line spacing of 19 meters and a survey speed of 5 kts was 
determined to be an operationally feasible compromise between maintaining resolving-
capability across the entire swath and minimizing the time needed to complete the survey.
Nineteen-meter line spacing was also based on ensuring that what was deemed the 
useable portion of each swath would overlap the usable portion of the adjacent swaths. 
The usable portion of each swath was deemed to be the portion of the swath containing 
footprints whose across- and along-track dimension did not exceed 0.8 meters.
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1.2 Multibeam Echo Sounder Acquisition and Monitoring

A pre-survey workflow, developed for the purposes of quality control, was implemented
at the start of each survey day.  The workflow is included in Figure 4.

Figure 4 Pre-survey workflow.

Pre-survey protocol involved measuring and entering into SIS the waterline value,
checking the surface sound speed output from the Digibar, ensuring that RTK corrections 
were being received by the POS/MV, enabling Ethernet logging, and running the EM 
3002D built- in self-test in the SIS software.  Other pre-survey checks included verifying 
the IMU-to-transducer offsets in the SIS installation, the MBES angular sector and 
operation mode in the SIS runtime parameters, and the IMU-to-port antenna offsets 
applied in the POS/MV controller software.  Also, a new SV Plus sound velocity cast was 
loaded into SIS prior to each individual survey.

A standard logbook for MBES acquisition and monitoring was filled out by survey
personnel at the time of acquisition.  The logbook contained fields for survey date and 
vessel, local weather conditions, personnel inventory, draft tube readings, sound velocity
casts, and MBES line remarks.
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Additional checks were made to ensure accuracy during data acquisition and monitoring.
When surface sound speed from the Digibar deviated significantly (more than 2-3 m/s) 
from the surface sound speed from the SV Plus cast, a new sound speed cast was 
acquired and applied in the SIS software.  The numerical display in SIS was also closely 
monitored for any irregular behavior.  Additionally, starting on the final day of
acquisition, after the POS/MV was observed periodically receiving RTCM rather than 
CMR correctors, the GPS mode was displayed in Hypack and monitored for RTK
outages.

1.3 Survey Crosslines

A total of 23.94 linear nm of main scheme lines and 1.753 linear nm of survey crosslines 
(7.32% as compared to main scheme) were acquired for the project. The crossline 
comparisons were performed by comparing for each survey a crossline BASE surface and 
a mainscheme BASE surface using the Pydro checkpoint functionality.  Within each 
survey, there is excellent agreement between the mainscheme surface and the crossline 
surface.  Table 6 summarizes the crossline comparisons performed for each survey.  The 
Pydro-generated crossline comparison reports are included in Separate IV.

Table 6 Crossline comparisons.
# of Comparisons

(depth range)
Mean

DifferenceSurvey
[10,15) [15,20) [10,15) [15,20)

% Special 
Order % Order 1

1 56213 27045 -0.04 0 100 -

2 80257 36166 0.02 0.05 100 -

3 76308 08660 0 0.02 99.9 0.1

4 63539 25423 -0.03 -0.01 100 -

5 87074 31023 0.01 0.03 100 -

1.4 Gridded Surface Uncertainty

Table 7 summarizes the uncertainty and standard deviation of the five gridded surfaces.
Every uncertainty value (i.e., an a priori estimation of error given the assumed error 
model) and the averages of the standard deviations (i.e., an a posteriori estimation of 
uncertainty) of every gridded surface are within the acceptable IHO error for Special 
Order surveys; however, the expected uncertainty values are approximately an order 
magnitude greater than the average of the observed standard deviations.  Such a condition 
may suggest that the errors of the survey system were overestimated.  Given the very 
close proximity of the water level gauge, the relatively calm sea conditions during the 
times of survey, the centimeter-accuracies associated with RTK positioning, and the 
relatively shallow depths in the survey area, actual errors close to the observed standard 
deviations may not be unlikely.
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Table 7 Gridded surface uncertainty and standard deviation.
Uncertainty Standard DeviationSurvey min max mean min max mean

1 0.208 0.225 0.219 0 0.529 0.034
2 0.212 0.234 0.220 0 0.700 0.037
3 0.211 0.239 0.220 0 0.507 0.037
4 0.209 0.242 0.219 0 0.566 0.035
5 0.213 0.239 0.220 0 0.533 0.038

1.5 Gridded Surface Difference

Surface differences of the final BASE surfaces were calculated using CARIS BASE 
Editor.  A difference surface calculated by subtracting Survey 5 (collected DN 165, 13:25 
– 14:42 UTC) from Survey 2 (collected DN 165, 19:34 – 20:49 UTC).  The difference 
surface is included in Figure 5. The differences (alternating vertical offsets -0.439 m to 
0.797 m in magnitude) visible in the difference surface indicate systematic errors in the 
data.  These systematic errors are presently not well understood, but may be the result of 
improperly applied vessel static draft, variations from the experimentally determined 
dynamic draft, and/or a heave frequency below the lower cutoff of the high pass heave 
filter in the POS/MV controller software.

Figure 5 Surface difference calculated from subtraction of Survey 5 (DN 165, 13:25 – 14:42 UTC) from 
Survey 2 (DN 165, 19:34 – 20:49 UTC).  Minimum and maximum differences are -0.439 m and 0.797.
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B3.  Corrections to Echo Soundings

1.0 Vessel HVFs

The CARIS HIPS Vessel File (HVF) was used to define the survey vessel offsets and 
equipment uncertainty.  The HVF was used for converting and processing data collected 
by the survey platform.  An HVF report produced in the CARIS Vessel Editor is included 
in Appendix V.

2.0 Vessel Configuration Parameters 

Sensor offsets aboard R/V COASTAL SURVEYOR were measured on June 1-2, 2007 at
the Jackson Estuarine Laboratory pier, Adams Point, Durham, NH.  Sensor offsets were 
measured with respect to the vessel’s reference mark (RP) at the top center of the 
POS/MV inertial measurement unit (IMU). Offsets from the IMU to the primary (port)
GPS antenna and from the IMU to the port and starboard transducers were measured 
using tape measures, rulers and a t-square.  The measurement uncertainties of the X, Y 
and Z sensor offsets (0.002 m, 0.003 m, and 0.003 m, respectively) are the calculated 
RMS values of the standard deviations of redundant X, Y and Z offsets and were entered 
into the TPE section of the CARIS HVF.

Offset values were applied in the MV-POSView and SIS software prior to data
acquisition.  The IMU-to-port antenna separation was entered into the MV-POSView
lever arm tab.  The separation between IMU and the port and starboard transducers and
the mounting angles of the transducers were input into the sensor location fields in the 
SIS software.

Transducer and primary GPS antenna offset measurement reports for R/V COASTAL 
SURVEYOR are included in Appendix V.

3.0 Static Draft and Loading 

Static draft was measured prior to surveying each day by measuring the distance from the 
water level in the in-board draft tube relative to a marked point +0.300 m from the vessel 
RP. The measured draft value was entered as the waterline in the SIS software prior to 
surveying.  At the end of each survey day a subsequent draft va lue was measured as a 
check to verify that there were no significant changes in the vessel’s draft.

The waterline values for DN 159, 165 and 166 were 0.510 m, 0.521 m, and 0.529 m. Of
the waterline values, only those for DN 166 were correctly entered into SIS during data 
acquisition. On DN 159 the waterline measurement entered into SIS (0.533 m) was 
measured from a closed draft tube, resulting in a difference of -0.023 m from the
waterline measured at the end of the survey day.  On DN 165 the value for the previous 
day (0.510 m) was applied in SIS for a difference of +0.011 m relative to the measured 
value.
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The waterline measurement uncertainty was estimated to be 0.01m and was entered into 
the TPE section of the CARIS HVF.

4.0 Settlement and Squat

Dynamic draft correctors for R/V COASTAL SURVEYOR were taken from the 2006 
Summer Hydrographic Field Course modeled values, which were based on RTK GPS
measurements.  The 2006 results were applied in the CARIS HVF during post-
processing. The dynamic draft measurement uncertainty calculated by the 2006 field 
course personnel (0.12 m) was entered into the TPE section of the CARIS HVF.

Table 8 contains the results of the 2006 dynamic draft experiment.  A full description of 
the 2006 dynamic draft experiment is available in the 2006 R/V COASTAL SURVEYOR
Hydrographic Field Course Descriptive Report (Registry Number W00178).

Table 8 Dynamic draft measurement table (CARIS coordinate system).
Speed (kt) Errors (kt) Height (m) Errors (m)

0.000 +/- 0.790 0.000 +/- 0.0448
1.000 +/- 0.790 -0.025 +/- 0.0448
2.000 +/- 0.790 -0.040 +/- 0.0448
3.000 +/- 0.790 -0.043 +/- 0.0448
4.000 +/- 0.790 -0.035 +/- 0.0448
5.000 +/- 0.790 -0.017 +/- 0.0448
6.000 +/- 0.790 0.012 +/- 0.0448
7.000 +/- 0.790 0.053 +/- 0.0448
8.000 +/- 0.790 0.104 +/- 0.0448
9.000 +/- 0.790 0.166 +/- 0.0448

10.000 +/- 0.790 0.239 +/- 0.0448

5.0 Patch Test

A patch test for the EM3002D dual-head multibeam system on the R/V COASTAL
SURVEYOR was conducted on June 8, 2007 (DN 157). The patch test was processed
independently for the port and starboard transducers using the CARIS HIPS calibration 
utility. The pitch, roll, and heading biases obtained for the port and starboard transducers 
were entered into the Swath1 and Swath2 sensors, respectively, and the average of the 
port and starboard timing biases was entered into the navigation sensor (Table 9).

The survey area for the patch test was under 1 nm southeast of Odiornes Point, NH, and 
was selected on the basis of bathymetry acquired in 1994 by NOAA Ship RUDE.  Biases 
were determined by surveying a series of planned survey lines at different speeds and 
headings over a pre-selected patch of seafloor.  A chartlet of the patch test survey area is
included in Figure 6.  The patch test report is included in Appendix V.
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Table 9 Patch test offsets .

Port
Transducer

Starboard
Transducer

Timing 0.110 0.110
Pitch 1.810 1.290
Roll -0.990 -1.600
Yaw -0.580 0.010

Figure 6 Patch test location over NOAA Chart 13283 with surfaces created from lines collected for timing, 
pitch, roll, and heading calibration.

6.0 POS/MV Correctors

6.1 POS/MV GAMS Calibration

A GAMS calibration was performed on June 6, 2007 (DN 157).  A report detailing the 
GAMS calibration is included in Appendix V.
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6.2 Attitude Computation

The instantaneous pitch, roll and heading values computed by the POS/MV were applied
as correctors to the MBES data in real time during data acquisition.  Specifications for the 
POS/MV obtained from the manufacturer indicate a roll/pitch measurement accuracy of 
0.010° for RTK solutions, and a heading measurement accuracy of 0.020° for a 2m 
antenna baseline and RTK/DGPS solution.

6.3 Heave Computation

The instantaneous heave values computed by the POS/MV were applied as correctors to 
the MBES data in real time during data acquisition.  Specifications for the POS/MV 
obtained from the manufacturer indicate a heave measurement accuracy of the greater of 
0.050 m or 5% of the heave amplitude.

TrueHeave data were acquired with respect to the IMU in MV-POSView during data 
acquisition. Though logged, the TrueHeave data were not applied to the sounding data in 
post-processing because the sounding solutions present in the *.all file converted into 
CARIS had offsets applied during data acquisition, and were therefore referenced to the 
transducers.

7.0 Sound Speed Correctors

Sound speed measured at the transducer head was applied as a corrector to the data in the 
SIS software in real time to facilitate beam steering by the EM3002D.  Additionally, 
sound speed casts from the SV Plus were processed and applied to the data in the SIS 
software as correctors to the echosounder data.

A description of all sound speed casts applied to the data is included in Separate 2.

8.0 Water Level Correctors

Preliminary water levels from the NOAA gauge at Fort Point, New Castle, NH (ID: 
8423898) were used to reduce sounding data to the MLLW chart datum.  A detailed 
description of the water level corrections applied to the data is available in Section C1 
(Vertical Control).
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B4.  Data Processing

1.0 Multibeam Echo Sounder Data Processing

The acquired multibeam data collected on June 8 and 14-15, 2007 (DN 159 and 165-166)
were processed using CARIS HIPS 6.1 software.  At the end of each survey day, the 
acquired data were checked for any holidays and artifacts as well as blunders or other 
errors.  The final processing was carried out from June 18-21, 2007. The steps involved 
in processing were logged using a check sheet to avoid processing-ambiguity and 
establish quality control.  Processing logs are included in Separate 1.

1.1 Processing Workflows

A workflow depicting the steps involved in CARIS HIPS/SIPS data processing is
included in Figure 7.

Figure 7 CARIS HIPS 6.1 data processing workflow.

1.2 Data Cleaning and Filtering Procedures

The first step taken in multibeam data processing was the creation of a HIPS vessel 
configuration file (HVF).  This file normally contains the sensor offsets; however, since 
these offsets had already been applied in the SIS and MV-POSView software, offsets in 
the CARIS HVF were set to zero.  The HVF contained the dual-head transducer pitch, 
roll and yaw values and timing offset determined from the patch test.  The dynamic draft 
table was applied in the draft table of the HVF.  Information regarding the model and 
manufacturer of the sensors was also included in the HVF. An HVF Report produced in 
the CARIS Vessel Editor is included in Appendix V.
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Along with vessel configuration information, the HVF also contains information used for 
calculating Total Propagated Error (TPE) values for the multibeam data. The TPE
section of the HVF contains all sensor offset values, as well as the transducer head roll 
angles. Standard deviation values for gyro, heave, roll, pitch, position, and timing are 
taken from the CARIS HIPS and SIPS TPE Computation Resource
(http://www.caris.com/tpe/), which is based on manufacturer specifications.  X,Y, and Z 
offset standard deviation values are based on the RMS values of redundant measurements 
for each offset.  Other standard deviation values are based on empirical estimates of field 
work.

The next step in the CARIS data processing routine was to create a project file.  The 
project file contains the vessel file, survey area boundaries, and projection.  The project 
file is used to manage the raw multibeam data and all information about the data that was 
flagged during the editing process.

The multibeam data were imported into CARIS HIPS as raw Simrad *.all files and were 
subsequently converted into CARIS proprietary data file format.  Next, a tide file was
loaded for the imported lines to apply the tidal correction.  The tide file was created from 
preliminary water level data from the NOAA tide gauge installed at Fort Point (ID: 
8423898) that were downloaded from the NOAA CO-OPS website.  Subsequent to 
loading the tide file, lines were merged to apply the tidal correction and HVF file.

Once the TPE values were computed, depth soundings were filtered to reject all data with 
a horizontal positioning accuracy of greater than 0.5 m. This filter is depicted in Figure 
8.

Figure 8 TPE filter settings.
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A swath filter was applied to selected survey lines, whereby the swath angle was limited 
to 45 degrees on either side.  This filter was applied because small artifacts were 
observed in the outer beams of some survey lines, and rejecting the outer beams tended to 
remove the artifacts.  The processing logs, included in Separate I, indicate all lines to 
which the swath filter was applied.

The navigation editor was used to check and correct navigational error.  A query was 
made to detect abrupt jumps in vessel speed, but no such incidents were detected in the 
data.  Similarly, a check for anomalous changes in attitude sensor data revealed no 
significant issues.

After cleaning and filtering, the survey lines were re-merged to compute final depth 
values taking into consideration all the defined parameters, offsets and dynamic
correctors.

1.3 BASE Surfaces

A BASE surface was created for each survey using the CUBE algorithm.  Each surface 
was created with a resolution of 0.25 m, the IHO S-44 Order specified as Special Order, 
and the disambiguation method set to Density and Locale.  The parameter menus are 
shown in Figure 9. After creation of the CUBE surface, the subset editor was used to 
investigate areas where the CUBE algorithm assigned more than one hypothesis for depth 
measurement.  With very few, minor exceptions, the primary CUBE hypotheses were
deemed correct and no manual assignments were made. After subset editing, the CUBE 
surface was re-computed and finalized.  Final uncertainty for the finalized BASE surface 
was taken from the greater of the uncertainty and the standard deviation (scaled to the 
95% confidence interval).

Figure 9 CUBE Parameter Setup.
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1.4 Final Product

The final products include the CARIS HIPS Bathymetry Associated with Statistical Error 
(BASE) surface computed at 0.25 m resolution, as well as the Bathymetric Attributed 
Grid (BAG) or Open Navigation Surface (ONS).  A final BASE surface of Survey 2 (DN 
159) is presented in Figure 10.  The Navigation Surface is a gridded product that allows 
the optimal level of detail to be preserved and contains information regarding uncertainty, 
designated soundings, elevation and metadata.  Software and more information regarding 
the BAG can be found at http://www.opennavsurf.org/.  A BAG and BASE surface was 
created for each survey in accordance with Section 8.5.3 (Shallow-Water Multibeam and 
Lidar Data) of the NOAA NOS Hydrographic Surveys Specifications and Deliverables 
(April 2007).
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Figure 10 Final 0.25 m BASE surface of Survey 2 (DN 159) with soundings.
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C. VERTICAL AND HORIZONTAL CONTROL

C1.  Vertical Control

The NOAA tide gauge station at Fort Point, New Castle, NH (ID: 8423898; location 43°
3.4’ N, 70° 42.7’ W) was used to reduce sounding data to chart datum (MLLW), which 
was used as the vertical datum for the survey.  Discrete tidal zoning for the tidal data 
from this station was provided by NOAA Center for Operational Oceanographic Products 
and Services (CO-OPS); however, the data need not be corrected as the zoning scheme 
indicates a zoning time corrector of 1 minutes and range corrector of 1.00 from the Fort 
Point tide station.

On June 6, 2007, the NOAA tide gauge station was leveled with respect to six tidal 
benchmarks located within a 0.2 m radius of the station.  The benchmark stamping 
numbers are NO 2 1919 (primary), NO 1 1919, NO 6 1994, CONSTITUTION 147 NO 1 
1841, BM 4 TIDAL US, and PORTSMOUTH USCG 1994.

Tidal data were also logged by a secondary tide gauge established in the vicinity of the 
NOAA gauge by 2007 Summer Hydrographic Field Course personnel.  The second gauge 
was established due to observed data dropouts in the NOAA gauge.  However, no data 
dropouts were observed in the NOAA preliminary tides during the times of survey, and 
measurement error on the NOAA gauge was resolved prior to the start of survey (the 
controller to the Aquatrak acoustic sensor was replaced by CO-OPS personnel on June 7,
2007). A report of vertical control activities is included in Appendix IV.

Figure 11 Plot of difference between predicted and preliminary observed water levels
from NOAA tide station (ID: 8423898) at Fort Point, New Castle, NH.
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C2.  Horizontal Control

Horizontal control for the survey was established with Real Time Kinematic (RTK) GPS 
correctors integrated into the POS/MV system. RTK correctors were provided by a 
Trimble RTK network established within line-of-sight of the survey area.  Horizontal
control was established relative to the NAD 83 reference ellipsoid.

1.0 Real Time Kinematic (RTK) GPS Network

An RTK base station was set up at the Seacoast Science Center, Odiornes Point, Rye, 
NH. This site was chosen because it had a clear line-of-sight to each survey location. The 
base station consisted of a Trimble 5700 receiver (S/N: 2203582930) and Zephyr antenna 
(S/N: 60073787) connected to a Trimmark3 modem (S/N: 456152537).  Differential
corrections were broadcast on Channel 5 at a frequency of 462.3750 MHz. The transmit 
power was set to 10 W encompassing a line-of-sight radius of over 5 to 6 miles. The 
Compact Measurement Record (CMR) format was chosen to broadcast the RTK
corrector to the rover unit. The transmission was set for a baud rate of 19200 bits per 
second (bps). The broadcasting radio antenna was mounted approximately 10 m high, and 
was connected via a low loss RG233 coaxial cable.  The base station was configured 
using a NOAA laptop (S/N: 29360279953) running GPS Configurator (v. 3.2.0.0)
software, connected to the Trimble 5700 receiver via serial cable. 

The RTK rover station on R/V COASTAL SURVEYOR consisted of a Trimmark3 
modem (S/N: 456152531) and antenna mounted next to the mast of the vessel for direct 
reception of the RTK corrector from the base station. The Trimmark3 output was
channeled to the POS/MV, which provided navigation information to the sonar system. 

2.0 GPS Data Processing

For positional refinement, raw GPS observations were logged at the base station for over 
two hours and submitted to National Geodetic Survey (NGS) Online Positioning User 
Service (OPUS).  OPUS then processed the GPS observations using NGS computers and 
software to determine the accurate position, which was subsequently entered into the base 
station during configuration.  The refined position of the base station calculated by OPUS 
was (f = 43º 02’ 43.372” N, ? = 070º 42’ 49.699” W, height= -13.912 m) relative to the 
NAD 83 reference ellipsoid. The accuracy of the base station determined by OPUS is 
such that the horizontal root mean square value of the measurements is 0.021 m and 
0.025 m along the vertical dimension. 

The base station was configured for NAD 83 based on post-processed coordinates 
provided by OPUS relative to the NAD 83 reference ellipsoid.  The RTK rover station, 
however, was configured for WGS 84 and thus received a “pre-RTK-corrected” position 
fix relative to the WGS 84 reference ellipsoid.  However, the CMR corrections received 
by the rover station (broadcast in NAD 83 from the base station) effectively changed the 
rover’s reference datum from WGS 84 to NAD 83.  The difference between CMR



26

corrections relative to WGS 84 and NAD 83 are millimeter-scale, thus the effect on the 
positioning data is considered negligible.

3.0 Data Quality Factors

On the last survey day (DN 166) sporadic outages of CMR corrections were noticed by 
survey personnel. During those few moments (~15 s maximum) of CMR outages, the 
POS/MV system switched over to the RTCM differential signal received by the
integrated WAAS antenna. However, no jumps in the navigation or attitude data were 
noticed. This is attributed to the high quality inertial navigation system built into the 
POS/MV, which can maintain accurate positioning for several minutes after loss of CMR
correctors. The positional accuracies reported by the POS/MV were less than 0.03 m 
throughout the survey, except during times of CMR outage, during which it jumped to 
0.5 m.

At the end of the project, survey personnel discovered that the raw GPS data was not 
logged during the survey period. Hence, GPS raw data were acquired from a Continuous 
Operating Reference Station (CORS) (ID: NHUN) GPS base station installed in 2005 at 
the University of New Hampshire.  Further information regarding this CORS station is 
available at http://fac-gis.unh.edu/.

D.  RESULTS AND RECOMMENDATIONS

D1.  Chart Comparison

1.0 Chart Comparison Methods

The final BASE surfaces were compared with NOAA Raster Navigational Chart (RNC) 
13283, scale 1:20 000, 19th edition, corrected through June 9, 2007. The most recent
Weekly (25-2007; June 23, 2007) and Local Notices to Mariners (24-07; June 11, 2007)
published at the time of the chart comparison were found to contain no further corrections 
to the NOAA RNC.

Chart comparison was accomplished using CARIS HIPS/SIPS 6.1.  A visual comparison 
was performed between the RNC, the final BASE surface, and a soundings layer derived
from the BASE surface. Soundings were generated by CARIS Field Sheet Editor using 
shoal-biased radius selection criteria, whereby the least depth within 3.00 mm of each 
grid node at the 1:10 000 survey scale was selected for display. All soundings were 
rounded to the nearest survey foot using NOAA Sounding Rounding rules.

Comparison was made between the BASE surfaces, NOAA charted soundings, and 
charted shoals and potentially dangerous features.  Additionally, general agreement and 
trends between the BASE surface and RNC were evaluated.
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2.0 Comparison with Charted Soundings

Overall agreement between the charted depths of NOAA chart 13283 and the present
survey soundings is very good, considering the differences in age, sounding methods, and 
horizontal and vertical control between the present survey and the survey(s) used to 
compile the chart. However, it is noted that the comparison was limited to the seven total
charted soundings present within the survey area at the largest chart scale available (1: 20 
000).

The BASE surface indicates neither a shoaling nor deepening trend within the survey
area as compared with the chart.  Rather, the minor differences from charted values in 
this survey area (~2 feet or less) may be explained by discrepancies in horizontal control 
between the two products. The survey area encompasses part of the Portsmouth Harbor 
main channel, and it appears that there are no major discrepancies between the survey 
and the reported depth of the main channel.

3.0 Comparison with Shoals and Potentially Dangerous Features

No shoals or potentially dangerous features are presently charted within the survey area, 
nor does the current survey indicate any significant changes to NOAA chart 13283.
Because there are no identified dangers to navigation within the survey area, no Danger
to Navigation Reports have been submitted for this survey.

Additional targets located by the survey include a 15-m long object at 43.06765°N,
70.70656°W that may be a partially bur ied outcrop or wreck, and a 3x3-m rectangular 
object at 43.06784°N, 70.70552°W.  Heavy scouring observed around the rectangular 
object is indicative of strong currents in this area.  Neither object is expected to pose a 
danger to navigation.  The least depth on the partially buried object is 31 ft, while the 
least depth on the rectangular feature is 39 ft.  These features have been documented in 
the Survey Feature Report included in Appendix II.

4.0 Recommendations

No significant differences between the charted depths and the character of the seafloor as 
captured by the final surfaces were noted.  As such, no recommendations  are made to the 
existing NOAA chart 13283.  However, NOAA may want to investigate the two
uncharted features listed in the attached Survey Feature Report (Appendix II) as time and 
resources permit.

D2.  Additional Results

1.0 Shoreline Verification

No shoreline is included within the survey limits.
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2.0 Prior Survey Comparisons

No prior survey comparisons were conducted.

3.0 Aids to Navigation

All aids to navigation encountered within the survey vicinity were observed to serve their 
intended purpose.  Aids to navigation within the survey vicinity include green day marker 
no. 3A and green buoy no. 3.

4.0 Bridges, Overhead Cables and Overhead Pipelines

No bridges, overhead cables, or overhead pipelines are located within the survey limits.

5.0 Ferry Routes

No ferry routes or ferry terminals are active within the survey limits.

6.0 Submarine Cables and Pipelines

NOAA chart 13283 identifies a submarine cable crossing within the survey area,
although there is no indication of any submerged cables in the 0.25 m grid resolution 
BASE surfaces generated from the MBES data. No crossing signs were observed on the 
shoreline.

7.0 Scientific Results

The major objective of this project was to survey a large sand shoal south of Fort Point 
multiple times, with sub-meter horizontal positioning uncertainty, to detect bedform 
migrations during the planned survey period. A difference surface generated from 0.25-
m grid resolution BASE surfaces of Surveys 2 and 5 (DN 159 and 166) using CARIS 
Base Editor indicates a maximum -0.4 m shift on the lee (N) edge of sandwaves along the 
eastern perimeter of the shoal.  This difference would appear to indicate flood-oriented
migration in this area during the survey period.  However, the a priori horizontal
positioning uncertainties of the final BASE surfaces are all within the 0.20 – 0.25 m 
range (the standard deviations of the final BASE surfaces, on the other hand, are less than 
0.1 m), which makes any interpretation difficult at this time. Furthermore, centimeter- to 
decimeter- level vertical shifts between survey datasets, visible in the difference surfaces
(Section B2, 1.5, Gridded Surface Difference), will need to be resolved before bedform
migration can be interpreted from the data.
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IV.A.1 - TIDE AND WATER LEVELS

IV.A.1.i - Station Description

A back up water level sensor was installed on June 4, 2007 at the US Coast guard base 
Portsmouth Station in New Castle, New Hampshire in support of the Field Hydrographic
Course at the University of New Hampshire. The reason for the installation was because 
the permanent tide gauge installed and operated by NOAA was showing data gaps in both 
the transmission and on the internal data logger.   Data from the newly installed back up 
water level sensor would be used to fill any gaps in the data from the primary NOAA 
gauge if necessary.

On June 7, 2007 Carl Kammerer of the Joint Hydrographic Center (JHC) replaced the 
Aquatrak Controller in the NOAA gauge.  After the replacement of the controller there 
were three data gaps each of which were only 6 min long.  The gaps were on June 6, 
2007 at 12:12 (UTC), June 9, 2007 at 21:00 (UTC) and June 13, 2007 at 19:24 (UTC).
Surveying for this project was scheduled to be done between June 11th and 13th.
However, due to rough seas, 3-5 ft, no data was collected on June 13th.  Thus the 
previously mentioned gaps in the primary gauge data did not effect the survey.

In order to prepare for the back up gauge installation a team of students from the Center 
of Coastal and Ocean Mapping (CCOM) made a reconnaissance trip to the site and 
determined the most appropriate location to install the backup gauge was along was along 
the eastside of the covered Coast Guard pier.  This location was chosen because of its 
vicinity to the survey area and the primary NOAA gauge, the USCG pier provided an 
excellent structure for mounting the gauge and a floating dock provided a working
platform for banding the sensor’s cable to the piling.

The backup sensor was mounted inside a 4-in diameter white PVC pipe using a 5” 
stainless steel section of althread.  This section of althread penetrated through both the 
pipe and mounting hole on the end of the sensor (see IV.A.2).  Stainless steel nuts and 
washers were used to fasten the sensor in an upright position to prevent pivoting of 
sensor around the mounting rod. The offsets for the sensor int eh PVC pipe are shown in 
appendix IV.A.3. The 10-ft PVC pipe was attached to the piling with steel banding.  The 
cable connecting the sensor to the datalogger was routed up the same piling the PVC pipe 
was mounted to, under the wood flooring of the pier and inside the covered building
where the entire logging unit; which includes the logger, battery, compensating unit and 
external battery; rested in  place against a metal support beam.  Mounting the logger 
inside the building both protected the unit from weather, which was important because 
the unit itself was not fully weather resistant and water leaked through the seam around 
the door, and provided a dry place for the tide observer to download data or perform 
maintenance on the logger.

The primary NOAA water level sensor is an Aquatrak acoustic sensor with a SUTRON 
data logger.  The sensor has an accuracy of ±0.025% of the range and a resolution of 



0.001 m, these specifications can be found on the Aquatrak website
http://www.aquatrak.com/.  The backup water level sensor is an Aanderaa strain gauge 
with an accuracy of ±0.2% of the range and a resolution of 0.1% of the range.

IV.A.1.ii - Logging Parameters

The CCOM backup gauge was programmed to log battery voltage, water level, and water 
temperature every 30 seconds.  It takes 15 seconds to log all four measurements, 5
seconds for battery voltage, 5 sec for water level and 5 sec for water temp. Each
measurement is a 30 sec average time stamped with the time at the beginning of the first
measurement. The raw measurements from the Aanderaa sensor are converted to depth 
in meters using eq. 1.1 provided in the Aanderaa Instruments datasheet for water
level/temperature series 3791-3798.

2 3* * *( )
*

A B N C N D NWaterLevel m
d g
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 (1.1)

where A, B, C and D are coefficients given in the sensor’s calibration sheet, N is the raw 
data value measured by the logger, d is the density of water (g/cm3), and g is gravity.
The coefficient values for the backup sensor are shown in the table below.  Note that the 
table shows a value of 0.00 for water density and based on the sensor data sheet g is 
9,80665 (the international standard).  Uncertainty is introduced by the fact that these 
values are not site specific. 

CH Parameter Unit A B C D
00 Battery Voltage Volt +0.000E+00 +1.000E-02 +0.000E+00 +0.000E+00
02 Water Level m -8.645E-02 +5.138E-03 +6.808E-08 +0.000E+00
03 Water Temp Deg. C -7.823E+00 +4.321E-02 +5.084E-06 +0.000E+00
Table 1 – Coefficients in the Aanderaa datalogger used to convert from raw measurements to volts, 
m, and Deg. C.

The converted data (volts, m, Deg. C) were logged to a 128 Mb compact flash card in an 
Persistor Instruments Inc. external data logger.  The NOAA gauge takes a 181 sec 
average every 6 min on the hour (i.e. 00:06, 00:12, 00:18, …) and time stamp of the 
reading is centered in the averaging period

Drift of the Aanderaa Datalogger 3634 was monitored during maintenance trips.  The 
clock in the data logger was synced with GPS time, which was retrieved from a handheld 
Garmin GPS receiver, on the day of installation (June 4, 2007 UTC).  By June 13, 2007 
the datalogger was reading 7 sec slower than GPS time on the handheld receiver.

IV.A.1.iii - Sensor movement

The water level readings were tied into the local tidal datum though spirit leveling.
Installation levels were conducted on June 6 and 7 of 2007 and check levels were 
conducted on June 15, 2007 (see IV.A.3 and IV.A.4). There was a maximum difference 



in elevation of 0.002 m between  the 2007 installation levels and the NOAA published 
benchmark elevations, which can be found at the http://tidesandcurrents.noaa.gov,).

A total of 7.03 hrs of gauge to staff comparisons were observed during 5 different periods 
of time between June 4th and June 6th (see IV.A.5). A benchmark elevation drawing is 
shown in appendix IV.A.6. For each period of observations the average difference for 
the CCOM gauge to staff, NOAA gauge to staff, and NOAA gauge to CCOM gauge
comparisons were computed. The average of those five averages was then used as the 
final staff constant for each of the three comparisons.  Because of the 7 second clock drift 
in the Aanderaa datalogger (see IV.A.6) the measured water levels values from the 
Aanderaa sensor were interpolated to the 6 min interval using the MATLAB function
‘interp1()’ in order to compute the gauge to gauge comparisons. Residuals from the final
staff constant for each of the three comparisons show the NOAA sensor to be the most 
stable with a standard deviation of 0.007 m (see IV.A.7).  The fluctuation in comparisons 
of the CCOM gauge to the staff and the NOAA gauge suggested movement of the 
CCOM sensor. Check levels run on June 15, 2007 showed an elevation difference of -
0.001m which meant there was little to no movement in the sensor and the fluctuation in 
staff to gauge comparisons was due to either phase lag in the water level introduced by 
the stilling well or observer error.  Based on the gauge to gauge comparisons there was a 
measurement shift in one of the sensors that corresponds with the time Carl Kammerer 
replaced the Aquatrak controller in the NOAA gauge.  Prior to the replacement of the
controller there signal of the difference had an increasing trend of 0.006 m/day and a 
peak-to-trough amplitude of approximately 6cm.  After the controller was replaced the
trend reduces to -0.0001 m/day and the amplitude reduces to approximately 2cm (Fig. 
IV.A.1.iii.a).  The frequency of the signal appears to match that of the tidal signal with a 
positive difference during periods of low tide and a negative difference between periods 
of high tide.  This means that at high tide the Aanderaa sensor was reading higher than 
the Aquatrak whereas at low tide the Aanderaa sensor was reading lower than the 
Aquatrak. Also the amplitude of the signal in the differences appears to scale with the 
amplitude of the tide, as the amplitude of the tide increased the amplitude differences 
increased and as the amplitude in the tide decreased so did the amplitude of the
differences. Although the Aanderaa sensor installed for the CCOM gauge was last 
calibrated by the manufacture in June of 2000, which leaves suspicion as to the accuracy 
of the gauge, the record of differences between the two gauges over the 7 day period of 
time suggests the uncertainty of the data from the NOAA gauge was improved from 6 cm 
to 2 cm when the new Aquatrak controller was installed on June 7, 2007 at 20:18 (UTC). 



Figure IV.A.1.iii.a – The top plot is a seven day record of both the NOAA and CCOM gauges.  The 
blue line in the bottom plot is the difference between the two gauges.  The spike in the data is at 20:18 
(UTC) on June 7, 2007 and marks when the Aquatrak controller was replaced in the NOAA gauge.
The orange line is a linear fit to the data before the controller was replaced and the black line is a 
linear fit to the data after the controller was replaced.

IV.A.1.iv - Tidal zoning

A discrete tidal zoning for Piscatuaqua River Entrance was designed by CO-OPS.  This 
zoning scheme used NOAA gauge 8423898 Fort Point as the reference station.  The time
and range correctors for the survey area were -6 min and x1.00, respectively.   The 
uncertainty associated with the zoning scheme is approximately 0.2m (personal
correspondence with C. Kammerer)
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IV.A.10 - TIDAL BENCH MARK PHOTOS



Stamping: 2 1919 Lat: 43° 04’ 18.0” N
Designation: 842 3898 TIDAL 2 Long: 070° 42’ 42.0”W
Monument Type: US C&GS disk

Figure 1 -  Left photo is a close up of benchmark 2 1919.  Right photo is looking NE from benchmark 
2 1919 and shows NO 1 1919 in the background.

Stamping: NO 1 1919 Lat: 43° 04’ 16.8” N
Designation: 842 3898 TIDAL 1 Long: 070° 42’ 39.2”W
Monument Type: US C&GS disk

Figure 2 – Left photo is a close up of benchmark NO 1 1919.  Right photo is looking NE with 
benchmark NO 1 1919 in the foreground.  Note the NOAA tide gauge (Station number 8423898) at 
the SWcorner of the covered dock.



Alias: BM 4 Lat: 43° 04’ 16.8” N
Designation: 842 3898 TIDAL 1 Long: 070° 42’ 39.2”W
Monument Type: Bolt (iron rod in rock)

Figure 3 -  Left photo shows BM 4 which is an iron bolt drilled into a bedrock out crop.  Right photo 
is looking NE and shows the NOAA tide gauge in the background.

Stamping: NO 6 1944 Lat: 43° 04’ 17.6” N
Designation: 842 3898 TIDAL 6 Long: 070° 42’ 37.6”W
Monument Type: US C&GS disk

Figure 4 – Left photo is a close up of benchmark NO 6 1944.  Right photo is looking NNW and shows 
the location of the of the benchmark relative to the tide staff, which is mounted on one of the pilings 
shown.  The red arrow at the top of the right photos shows the approximate location of the tide staff. 
The sensor for the CCOM back up gauge is located a couple pilings seaward of the tide staff.



Stamping: Portsmouth USCG 1994 Lat: 43° 04’ 16.8” N
Designation: Portsmouth USCG Long: 070° 42’ 39.2”W
Monument Type: NGS disk

Figure 5 – Left photo is a close up of benchmark PORTSMOUTH USCG.  Right photo is looking SE
over benchmark PORTSMOUTH USCG and towards Went

Stamping: CONSTITUTION 147 NO 1 1941 Lat: 43° 11’ 53.2” N
Designation: CONSTITUTION 147 RM 1 Long: 070° 52’ 03.9”W
Monument Type: USC&G disk

Figure 6 – Left photo is a close up of benchmark CONSTITUTION 147 NO 1 1941.  Right photo is 
looking NNE from benchmark CONSTITUTION 147 NO 1941 and shows the location of the backup 
tide gauge in the background.



IV.A.11 - FORT POINT BACKUP TIDE GAGE 
MAINTENANCE PROCEDURES

Location of tide gauge:
Tide gauge is located along the inside of the east wall of the aluminum building covering 
the USCG pier.  It is leaning on the north-side of one of the pilings.

Maintenance Procedures:
1) Call USCG base to notify we will be working there
2) Staff shots

a. Read the water level on the staff mounted on the Eastside of the USCG 
pier every six minutes on the hour ex. 18:00, 18:06, 18:12, 18:18, 18:24, 
18:30, 18:36, 18:42, 18:48, 18:54

b. Simultaneously record what the gauge is reading
3) Check the time on the gauge (Compare GPS time to gauge)

a. Use handheld GPS 
b. Record time on GPS
c. Record time on Gauge

4) Download data from the gauge
a. Open gauge
b. Remove external data logger (black box) in lower left hand corner of 

gauge
c. Open logger using small screw driver
d. Press white button

i. The LED on the logger should be flashing green while the card is 
still in

ii. After pressing button the LED will flash red.  This means thed ata 
is being written to the compact flash card

iii. When the LED is solid green it is ready to be ejected. 
e. Eject compact flash card using black eject button
f. Download data using compact flash card adapter.

i. File will be at *.dat file
g. After downloading data inspect to make sure it looks reasonable

i. Times are correct, logging at 30 sec interval
ii. Battery voltage
iii. Reference number (76 or 77)
iv. Water level
v. Water temperature

h. Insert compact flash card back into the external logger
i. Replace screws
j. Tape the connection back onto logger

5) Copy data to server: \Shared\Tide Data\Fort Point Backup Gauge\Flash Card Data
data\Fort Point Backup Gauge \Flash Card Data

a. Create a folder and name it the date the file was downloaded in the 
yyyymmdd format ex. 20070604



IV.A.12 - FORT POINT BACKUP GAUGE MAINTENANCE 
CHECKLIST
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POS M/V offset measurements from primary (port) Zephyr GPS antenna to IMU 
reference mark.

R/V Coastal Surveyor POS M/V offset measurements were taken on June 1-2, 2007 by 
UNH graduate students participating the CCOM/JHC summer hydro course.
Measurements were taken using metal measuring tape, string and plumb bob, spirit-
levels, T-squares, and rulers.  When feasible multiple measurements were taken by 
different personnel.  The purpose of these measurements was to calculate the offsets 
needed for the proper operation of the POS M/V system.

Measurements were broken into separate X, Y, and Z components to minimize possible 
confusion during measurement taking, recording, and analysis.  See Figure 1 for an 
overview of measurement locations.  The IMU reference mark is indicated by a black and 
white circle on the top of the IMU, where the point of measurement is the junction of the 
four black and white quarters.

Figure 1:  General overview of measurement locations

Measurements including objects with a diameter (gooseneck and support stanchion) were 
measured taking the average of the near and far sides of the objects.  The interior cabin 
measurements to the gooseneck were taken on the near and far sides of the pipe wall.  All 
measurements are in meters and distances are relative unless otherwise specified.
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MEASURMENTS

VERTICAL

The vertical offset from the IMU reference mark to port Zephyr GPS antenna were run in 
the following sequence:
Phase Offset – Offset from base of antenna to phase center provided by Trimble (see 
Figure 2)
Z1 – Offset from base of Zephyr GPS antenna to top of eyelet on rail (this measurement 
included the washers under the antenna) – metal tape
Z2 – Offset from top of eyelet on rail to deck on bridge – string, plumb bob, and metal 
tape
Z3 – Offset from the deck of the bridge to IMU reference mark – spirit level, T-square,
and metal tape

Figure 3:  Z1 
measurement

location

Figure 2: Vendor provided 
Phase offset from base of 
Antenna

Figure 4:  Z2 and Z3 measurement
Locations       Figure 5: Vertical results

Phase Offset 0.046
Z1 2.150
Z2 1.14
Z3 0.264

PhaseOffset+Z1+Z2+Z3 = 3.600
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ATHWARTSHIPS

The athwartships offset from the IMU reference mark to port Zephyr GPS antenna were 
run in the following sequence:

PS1 – Offset from port Zephyr center to center of support stanchion – metal tape
PS2 – Offset from support stanchion to gooseneck – metal tape and T-square
PS3 – Offset from gooseneck to IMU reference mark – metal tape, string, plumb bob, and 
T-square

Figure 6:  PS1 measurement 
location

Figure 7:  PS2 measurement location
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Figure 8:  PS3 and FA 2 
measurement locations

Figure 9:  Athwartships results

FORE/AFT

Measurements including objects with a diameter (gooseneck and support stanchion) were 
measured taking the average of the near and far sides of the objects.  The fore/aft offset 
from the IMU reference mark to port Zephyr GPS antenna were run in the following 
sequence:

FA1 – Offset from support stanchion to gooseneck.  This measurement assumed that 
there was no fore/aft difference between the stanchion and antenna – metal tape and T-
square
FA2 – Offset from gooseneck to IMU reference mark (See Figure 8) – metal tape, T-
square, string and plumb bob

Figure 10:  FA1 measurement location

Figure 11: Fore/aft results

PS1 0.045
PS2 0.933
PS3 0.264

-(PS1)+PS2+PS3= 1.152

FA1 0.361
FA2 0.459

FA1+FA2= 0.099
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All values were converted into the POS M/V reference frame, where X is fore/aft positive 
forward, Y is athwartships positive starboard, and Z is up/down positive down.

Figure 12:  POS 
M/V reference to 
IMU GPS lever 
arm offsets as 
entered into POS 
controller
program before 
GAMS
calibration.

BASELINE

The baseline offset between the port and starboard Zephyr GPS antenna were measured 
using metal tape.  The average of six different measurements was 2.198.  This value was 
entered into the POS controller before GAMS calibration.

REMARKS

The X and Y offsets are each different by 0.001 after re-calculating the offset results.
Although these values are different from those entered into the POS controller, they are 
within the tolerances for those offset measurements for RTK as specified in the POS M/V 
v4 manual (0.005).
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APPENDIX

BASELINE MEASURMENTS

FORE/AFT MEASURMENTS
FA1

Observer Value Goose neck is aft of the Zephyr antenna
Pepe 0.342 Far side of stanchion and nearside of gooseneck
Pepe 0.299 Nearside of stanchion to nearside of goose neck
Pepe 0.422 Farside of stanchion and farside of goose neck
Pepe 0.379 farside of goose neck and nearside of stanchion

Average 0.361

Observer Value Goose neck is aft of the Zephyr antenna

FA2 Inside cabin
Observer Value Goose neck is aft of the IMU reference mark

Unk 0.414 Near side of gooseneck to IMU reference mark
Unk 0.504 Far side of gooseneck to IMU reference mark

Average 0.459

FA1 0.361
FA2 0.459

Total 0.099 Port Zephyr antenna is aft of the IMU refernce mark

Observer Value
Leonardo 2.197 m

Lynn 2.198 m
Marc 2.200 m

Janice 2.202 m
Pepe 2.193 m
Yasu 2.198 m

Average 2.198 m
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ATHWARTSHIPS MEASURMENTS
Offset from support stanchion to Zephyr antenna center
Value

0.022 Nearside of stanchion to GPS center
0.061 Farside of stanchion to GPS center
0.065 Farside of stanchion to GPS center
0.026 Nearside of stanchion to GPS center
0.068 Farside of stanchion to GPS center
0.027 Nearside of stanchion to GPS center

0.045 Support stanchion is outboard (port) of the Zephyr antenna

Offset from support stanchion to gooseneck on aft deck (outside)
Value

1.000 Farside of support stanchion and gooseneck
0.911 far side of support stanchion and nearside of gooseneck
0.955 nearside of support stanchion and farside of gooseneck
0.864 nearsid of suppoort stanchion and near side of gooseneck

0.933 Gooseneck is inboard (starboard) of support stanchion

Offset from gooseneck to IMU reference mark (inside cabin)
Value

0.278 Farside of gooseneck to IMU reference mark
0.250 Nearside of gooseneck to IMU reference mark

0.264 IMU reference mark is outboard (port) of gooseneck
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VERTICAL MEASURMENTS

Phase offset 0.046

Z1
Base of Port antenna to top of eye bolt

Observer Value
Marc 2.150
Lynn 2.152
Vasu 2.149
Yasid 2.152

Nathan 2.149
Janice 2.147

Average 2.150

Z2
Transferred height of top of eyebolt to bridge to bridge deck
Observer Value
Leonardo 1.143

Pepe 1.138
Vasu 1.139

Average 1.14

Z3
Transferred height of deck using spirit level and T-square to IMU reference mark
Observer Value
Leonardo 0.255

Pepe 0.233 bad measurment
Vasu 0.250 bad measurment
Pepe

(corrected
value) 0.263 Corrected for thickness of T-square
Vasu 0.278

Thanh 0.260
Thanh 0.261

Leonardo 0.267

Average 0.264
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Offset Report for POS/MV IMU Reference Mark to Port/Starboard Transducers
R/V Coastal Surveyor

1-2 June 2007

R/V Coastal Surveyor sensor offsets for the 2007 Summer Hydrographic Field Course 
were measured on 1-2 June 2007 by UNH graduate students partic ipating in the course.
Measurements were made using metal measuring tape, string and plumb bob, spirit 
levels, T-squares and rulers.  Redundant measurements were made by different field 
personnel whenever feasible. The purpose of undertaking the measurements was to 
calculate the offsets needed for the proper integration of EM3002D depth measurements 
with position and attitude data from the POS/MV system.

Measurements were divided into separate X, Y and Z components to minimize potential 
confusion during the processes of measurement, recording and analysis. Refer to Figures 
2-5 for a general overview of measurement locations.  The IMU reference mark is 
indicated by a black and white circle on the top of the IMU, where the point of
measurement is the junc tion of the four black and white quarters.

Figure 1. R/V Coastal Surveyor.
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IMU to Bow Centermark Offsets

Vertical

The vertical offset from the IMU reference mark to the bow centermark was measured in 
the following sequence:

Z1 – Offset from the IMU reference mark to IMU base
Z2 – Offset from the IMU base to the top of the stairs 
Z3 – Offset from top of stairs to top of starboard rail
Z4 – Offset from top of starboard rail to bow centermark

Table I.  Vertical offset results
Z1 0.168
Z2 -0.446
Z3 -1.126
Z4 0.501

Total Z Offset 
(Z1+Z2+Z3+Z4) -0.903

Athwartships

The athwartships offset from the IMU reference mark to the bow centermark was 
measured in the following sequence:

Y1 – Offset from the IMU reference mark to mark on top of stairs
Y2 – Offset from mark on top of stairs to mark on bridge floor
Y3 – Offset from mark on bridge floor to starboard door
Y4 – Offset from starboard door to starboard rail
Y5 – Offset from starboard rail to bow centermark

Table II.  Athwartships offset results
Y1 0.686
Y2 0.329
Y3 0.108
Y4 0.363
Y5 -1.354

Total Y Offset 
(Y1+Y2+Y3+Y4+Y5) 0.132
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Fore-Aft

The fore-aft offset from the IMU reference mark to the bow centermark was measured in 
the following sequence:

X1 – Offset from IMU reference mark to bottom of stairs
X2 – Offset from bottom of stairs to mark on starboard cabin door
X3 – Offset from mark on starboard cabin door to mark on starboard rail
X4 – Offset from mark on starboard rail to bow centermark

Table III.  Fore-aft offset results
X1 0.110
X2 0.668
X3 5.826
X4 1.531

Total X Offset 
(X1+X2+X3+X4) 8.135

Figure 2.  General overview of IMU to Bow Centermark measurement locations.
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Bow Centermark to Port Transducer Offsets

Vertical

The vertical offset from the bow centermark to the phase center of the port transducer 
was measured in the following sequence:

Z1 – Offset from bow centermark to transfer point
Z2 – Offset from transfer point to top of bow mount lip
Z3 – Offset from top of bow mount lip to mark on black line of bow ram
Z4 – Offset from mark on black line of bow ram to top of bow ram bracket
Z5 – Offset from top of bow ram bracket to top of mounting plate
Z6 – Offset from top of mounting plate to phase center of transducer

Table IV.  Vertical offset results
Z1 -0.339
Z2 -0.742
Z3 0.574
Z4 1.543
Z5 1.038
Z6 0.226

Total Z Offset 
(Z1+Z2+Z3+Z4+Z5+Z6) 2.300

Athwartships

The athwartships offset from the bow centermark to the phase center of the port 
transducer was measured in the following sequence:

Y1 – Offset from bow centermark to transfer point
Y2 – Offset from transfer point to mark on black line of bow ram
Y3 – Offset from mark on black line of bow ram to bow ram bracket
Y4 – Offset from bow ram bracket to phase center of transducer

Table V.  Athwartships offset results
Y1 0.000
Y2 -0.053
Y3 -0.026
Y4 -0.115

Total Y Offset 
(Y1+Y2+Y3+Y4) -0.194
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Fore-Aft

The fore-aft offset from the bow centermark to the phase center of the port transducer 
was measured in the following sequence:

X1 – Offset from bow centermark to transfer point
X2 – Offset from transfer point to mark on black line of bow ram
X3 – Offset from mark on black line of bow ram to top of mounting plate
X4 – Offset from top of mounting plate to transducer phase center

Table VI. Fore-aft offset results
X1 0.506
X2 0.401
X3 0.128
X4 -0.193

Total X Offset 
(X1+X2+X3+X4) 0.843

Bow Centermark to Starboard Transducer Offsets

Vertical

The vertical offset from the bow centermark to the phase center of the starboard 
transducer was measured in the following sequence:

Z1 – Offset from bow centermark to transfer point
Z2 – Offset from transfer point to top of bow mount lip
Z3 – Offset from top of bow mount lip to mark on black line of bow ram
Z4 – Offset from mark on black line of bow ram to top of bow ram bracket
Z5 – Offset from top of bow ram bracket to top of mounting plate
Z6 – Offset from top of mounting plate to phase center of transducer

Table VII.  Vertical offset results
Z1 -0.339
Z2 -0.743
Z3 0.570
Z4 1.552
Z5 1.037
Z6 0.221

Total Z Offset 
(Z1+Z2+Z3+Z4+Z5+Z6) 2.297
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Athwartships

The athwartships offset from the bow centermark to the phase center of the starboard 
transducer was measured in the following sequence:

Y1 – Offset from bow centermark to transfe r point
Y2 – Offset from transfer point to mark on black line of bow ram
Y3 – Offset from mark on black line of bow ram to bow ram bracket
Y4 – Offset from bow ram bracket to phase center of transducer

Table VIII.  Athwartships offset results
Y1 0.000
Y2 0.033
Y3 0.047
Y4 0.169

Total Y Offset 
(Y1+Y2+Y3+Y4) 0.248

Fore-Aft

The fore-aft offset from the bow centermark to the phase center of the starboard 
transducer was measured in the following sequence:

X1 – Offset from bow centermark to transfe r point
X2 – Offset from transfer point to aft point on transducer mount* 
(*carried up to mark on black line of bow ram)
X3 – Offset from aft point on transducer mount to phase center of transducer

Table IV.  Fore-aft offset results
X1 0.506
X2 0.197
X3 0.185

Total X Offset 
(X1+X2+X3+X4) 0.888
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Figure 3.  General overview of Bow Centermark to Port and Starboard Transducer offset 
measurement locations (see insets A and B).
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Figure 4.  Inset A.

Figure 5.  Inset B
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Remarks

Due to measurement discrepancies between the offsets from the IMU reference mark to 
the bow centermark as measured by the 2007 and 2006 Summer Hydrographic Field 
Course personnel, the more recent set of measurements were rejected in favor of the 
values obtained in 2006.  Therefore, the total offset between IMU reference mark to port 
and starboard transducers reflects the following:

IMU reference mark to Bow centermark
Measurement from 2006 CCOM Summer Hydrographic Field Course

X 8.211
Y 0.000
Z -0.844

Bow centermark to Port transducer
Measurement from 2007 CCOM Summer Hydrographic Field Course

X 0.843
Y -0.194
Z 2.300

Bow centermark to Starboard transducer
Measurement from 2007 CCOM Summer Hydrographic Field Course

X 0.888
Y 0.248
Z 2.297

Final Offsets

All values converted into the SIS – POS/MV reference frame, where X is fore/aft positive 
forward, Y is athwartships positive starboard, and Z is up/down positive down.

IMU to Port transducer
X 9.054
Y -0.194
Z 1.456

IMU to Starboard transducer
X 9.099
Y 0.248
Z 1.453
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EM3002 Beam Footprint Model

Nominal Depth (m) 19

Sonar Installation
TxSeperation (m) 0.50
MountingAngle (°) 40.0
Swath Characteristics
OperatingMode EA
PortSonarHead
     Port/Starboard Coverage 50 10
     OuterCutoff (°) 10
    InnerCutoff (°) 50

StarboardSonarHead
     Port/Starboard Coverage 10 50
     InnerCutoff (°) 50
     OuterCutoff (°) 10
InterSwathOverlap (m) 6.20
UseableTotalSwathWidth (m) 45.79
Survey Area
SurveyAreaWidth (m) 260
SurveyAreaLength (m) 520
Survey Speed (kts) 6.00
Mainscheme Lines
InterMBESLineSpacing (m) 19.0
MBESSwathOverlap (m) 26.79
NumberOfMBESLines 14
NauticalMilesOfMBESLines 3.93
TotalTimeForMBESLines (hr) 0.66
NumberOfTurns (lines - 1) 13
TimePerTurn (min) 1.50
TotalTimeForTurns (hr) 0.33
Cross Lines
NumberOfXLs 2.00
LengthOfXLs (m) 260
NauticalMilesOfXLs 0.28
TotalTimeForXLs (hr) 0.05
CTD Casts
NumberOfCTDs 4
TimePerCTD (min) 5.00
TotalTimeForCTDs (hr) 0.33

TotalTimeForSurvey (hr) 1.36
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3

Footprint Footprint
Beam Steering

Angle
Nadir
Angle

Across
Distance

Beam
Width Along Across

Beam Steering
Angle

Nadir
Angle

Across
Distance

Beam
Width Along Across

1 10.00 50.00 0.00 1.523 0.7738 1.22 161 50.00 10.00 19.79 2.334 0.5051 0.80
2 9.62 49.62 0.30 1.521 0.7678 1.20 162 49.62 9.62 19.92 2.315 0.5045 0.79
3 9.25 49.25 0.60 1.520 0.762 1.18 163 49.25 9.25 20.05 2.298 0.504 0.78
4 8.87 48.87 0.89 1.518 0.7562 1.16 164 48.87 8.87 20.18 2.280 0.5034 0.77
5 8.49 48.49 1.17 1.517 0.7505 1.15 165 48.49 8.49 20.31 2.263 0.5029 0.77
6 8.11 48.11 1.46 1.515 0.745 1.13 166 48.11 8.11 20.43 2.247 0.5024 0.76
7 7.74 47.74 1.74 1.514 0.7396 1.11 167 47.74 7.74 20.56 2.230 0.502 0.75
8 7.36 47.36 2.01 1.512 0.7343 1.09 168 47.36 7.36 20.69 2.214 0.5015 0.75
9 6.98 46.98 2.28 1.511 0.7291 1.08 169 46.98 6.98 20.82 2.199 0.5011 0.74
10 6.60 46.60 2.55 1.510 0.724 1.06 170 46.60 6.60 20.94 2.183 0.5007 0.73
11 6.23 46.23 2.81 1.509 0.719 1.05 171 46.23 6.23 21.07 2.168 0.5004 0.73
12 5.85 45.85 3.07 1.508 0.7141 1.03 172 45.85 5.85 21.20 2.153 0.5 0.72
13 5.47 45.47 3.33 1.507 0.7093 1.02 173 45.47 5.47 21.32 2.139 0.4997 0.72
14 5.09 45.09 3.58 1.506 0.7046 1.00 174 45.09 5.09 21.45 2.125 0.4994 0.71
15 4.72 44.72 3.83 1.505 0.7 0.99 175 44.72 4.72 21.58 2.111 0.4991 0.70
16 4.34 44.34 4.08 1.504 0.6955 0.98 176 44.34 4.34 21.70 2.097 0.4988 0.70
17 3.96 43.96 4.32 1.504 0.6911 0.96 177 43.96 3.96 21.83 2.084 0.4986 0.69
18 3.58 43.58 4.56 1.503 0.6867 0.95 178 43.58 3.58 21.95 2.071 0.4984 0.69
19 3.21 43.21 4.80 1.502 0.6824 0.94 179 43.21 3.21 22.08 2.058 0.4982 0.68
20 2.83 42.83 5.03 1.502 0.6783 0.93 180 42.83 2.83 22.20 2.045 0.498 0.68
21 2.45 42.45 5.26 1.501 0.6742 0.91 181 42.45 2.45 22.33 2.033 0.4979 0.68
22 2.08 42.08 5.49 1.501 0.6701 0.90 182 42.08 2.08 22.45 2.021 0.4977 0.67
23 1.70 41.70 5.72 1.501 0.6662 0.89 183 41.70 1.70 22.58 2.009 0.4976 0.67
24 1.32 41.32 5.94 1.500 0.6623 0.88 184 41.32 1.32 22.71 1.997 0.4976 0.66
25 0.94 40.94 6.16 1.500 0.6585 0.87 185 40.94 0.94 22.83 1.986 0.4975 0.66
26 0.57 40.57 6.38 1.500 0.6548 0.86 186 40.57 0.57 22.96 1.975 0.4974 0.65
27 0.19 40.19 6.59 1.500 0.6511 0.85 187 40.19 0.19 23.08 1.964 0.4974 0.65
28 -0.19 39.81 6.81 1.500 0.6475 0.84 188 39.81 -0.19 23.21 1.953 0.4974 0.65
29 -0.57 39.43 7.02 1.500 0.644 0.83 189 39.43 -0.57 23.33 1.942 0.4974 0.64
30 -0.94 39.06 7.23 1.500 0.6406 0.83 190 39.06 -0.94 23.46 1.932 0.4975 0.64
31 -1.32 38.68 7.43 1.500 0.6372 0.82 191 38.68 -1.32 23.58 1.921 0.4976 0.64
32 -1.70 38.30 7.64 1.501 0.6339 0.81 192 38.30 -1.70 23.71 1.911 0.4976 0.63
33 -2.08 37.92 7.84 1.501 0.6306 0.80 193 37.92 -2.08 23.83 1.902 0.4977 0.63
34 -2.45 37.55 8.04 1.501 0.6274 0.79 194 37.55 -2.45 23.96 1.892 0.4979 0.63
35 -2.83 37.17 8.24 1.502 0.6242 0.78 195 37.17 -2.83 24.08 1.882 0.498 0.63
36 -3.21 36.79 8.43 1.502 0.6211 0.78 196 36.79 -3.21 24.21 1.873 0.4982 0.62
37 -3.58 36.42 8.63 1.503 0.6181 0.77 197 36.42 -3.58 24.33 1.864 0.4984 0.62
38 -3.96 36.04 8.82 1.504 0.6151 0.76 198 36.04 -3.96 24.46 1.855 0.4986 0.62
39 -4.34 35.66 9.01 1.504 0.6122 0.76 199 35.66 -4.34 24.59 1.846 0.4988 0.62
40 -4.72 35.28 9.20 1.505 0.6094 0.75 200 35.28 -4.72 24.71 1.838 0.4991 0.61
41 -5.09 34.91 9.39 1.506 0.6065 0.74 201 34.91 -5.09 24.84 1.829 0.4994 0.61
42 -5.47 34.53 9.57 1.507 0.6038 0.74 202 34.53 -5.47 24.96 1.821 0.4997 0.61
43 -5.85 34.15 9.75 1.508 0.6011 0.73 203 34.15 -5.85 25.09 1.813 0.5 0.61
44 -6.23 33.77 9.94 1.509 0.5984 0.72 204 33.77 -6.23 25.22 1.805 0.5004 0.61
45 -6.60 33.40 10.12 1.510 0.5958 0.72 205 33.40 -6.60 25.34 1.797 0.5007 0.60
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46 -6.98 33.02 10.30 1.511 0.5932 0.71 206 33.02 -6.98 25.47 1.789 0.5011 0.60

47 -7.36 32.64 10.47 1.512 0.5907 0.71 207 32.64 -7.36 25.60 1.781 0.5015 0.60
48 -7.74 32.26 10.65 1.514 0.5882 0.70 208 32.26 -7.74 25.72 1.774 0.502 0.60
49 -8.11 31.89 10.82 1.515 0.5858 0.70 209 31.89 -8.11 25.85 1.767 0.5024 0.60
50 -8.49 31.51 11.00 1.517 0.5834 0.69 210 31.51 -8.49 25.98 1.759 0.5029 0.60
51 -8.87 31.13 11.17 1.518 0.5811 0.69 211 31.13 -8.87 26.11 1.752 0.5034 0.60
52 -9.25 30.75 11.34 1.520 0.5788 0.68 212 30.75 -9.25 26.24 1.745 0.504 0.59
53 -9.62 30.38 11.51 1.521 0.5766 0.68 213 30.38 -9.62 26.36 1.739 0.5045 0.59
54 -10.00 30.00 11.67 1.523 0.5744 0.67 214 30.00 -10.00 26.49 1.732 0.5051 0.59
55 -10.38 29.62 11.84 1.525 0.5722 0.67 215 29.62 -10.38 26.62 1.726 0.5057 0.59
56 -10.75 29.25 12.00 1.527 0.5701 0.67 216 29.25 -10.75 26.75 1.719 0.5063 0.59
57 -11.13 28.87 12.17 1.529 0.568 0.66 217 28.87 -11.13 26.88 1.713 0.507 0.59
58 -11.51 28.49 12.33 1.531 0.566 0.66 218 28.49 -11.51 27.01 1.707 0.5076 0.59
59 -11.89 28.11 12.49 1.533 0.564 0.65 219 28.11 -11.89 27.14 1.701 0.5083 0.59
60 -12.26 27.74 12.65 1.535 0.562 0.65 220 27.74 -12.26 27.27 1.695 0.509 0.59
61 -12.64 27.36 12.81 1.537 0.5601 0.65 221 27.36 -12.64 27.40 1.689 0.5098 0.59
62 -13.02 26.98 12.97 1.540 0.5582 0.64 222 26.98 -13.02 27.54 1.683 0.5105 0.59
63 -13.40 26.60 13.13 1.542 0.5563 0.64 223 26.60 -13.40 27.67 1.678 0.5113 0.59
64 -13.77 26.23 13.28 1.544 0.5545 0.64 224 26.23 -13.77 27.80 1.672 0.5121 0.59
65 -14.15 25.85 13.44 1.547 0.5527 0.63 225 25.85 -14.15 27.93 1.667 0.513 0.59
66 -14.53 25.47 13.59 1.550 0.551 0.63 226 25.47 -14.53 28.07 1.662 0.5138 0.59
67 -14.91 25.09 13.75 1.552 0.5493 0.63 227 25.09 -14.91 28.20 1.656 0.5147 0.59
68 -15.28 24.72 13.90 1.555 0.5476 0.62 228 24.72 -15.28 28.34 1.651 0.5157 0.59
69 -15.66 24.34 14.05 1.558 0.5459 0.62 229 24.34 -15.66 28.47 1.646 0.5166 0.59
70 -16.04 23.96 14.20 1.561 0.5443 0.62 230 23.96 -16.04 28.61 1.641 0.5176 0.59
71 -16.42 23.58 14.35 1.564 0.5428 0.62 231 23.58 -16.42 28.74 1.637 0.5186 0.59
72 -16.79 23.21 14.50 1.567 0.5412 0.62 232 23.21 -16.79 28.88 1.632 0.5196 0.59
73 -17.17 22.83 14.64 1.570 0.5397 0.61 233 22.83 -17.17 29.01 1.628 0.5206 0.59
74 -17.55 22.45 14.79 1.573 0.5382 0.61 234 22.45 -17.55 29.15 1.623 0.5217 0.59
75 -17.92 22.08 14.94 1.577 0.5368 0.61 235 22.08 -17.92 29.29 1.619 0.5228 0.59
76 -18.30 21.70 15.08 1.580 0.5354 0.61 236 21.70 -18.30 29.43 1.614 0.5239 0.59
77 -18.68 21.32 15.23 1.583 0.534 0.61 237 21.32 -18.68 29.57 1.610 0.5251 0.60
78 -19.06 20.94 15.37 1.587 0.5326 0.60 238 20.94 -19.06 29.71 1.606 0.5263 0.60
79 -19.43 20.57 15.51 1.591 0.5313 0.60 239 20.57 -19.43 29.85 1.602 0.5275 0.60
80 -19.81 20.19 15.66 1.594 0.53 0.60 240 20.19 -19.81 29.99 1.598 0.5287 0.60
81 -20.19 19.81 15.80 1.598 0.5287 0.60 241 19.81 -20.19 30.13 1.594 0.53 0.60
82 -20.57 19.43 15.94 1.602 0.5275 0.60 242 19.43 -20.57 30.27 1.591 0.5313 0.60
83 -20.94 19.06 16.08 1.606 0.5263 0.60 243 19.06 -20.94 30.42 1.587 0.5326 0.60
84 -21.32 18.68 16.22 1.610 0.5251 0.60 244 18.68 -21.32 30.56 1.583 0.534 0.61
85 -21.70 18.30 16.36 1.614 0.5239 0.59 245 18.30 -21.70 30.70 1.580 0.5354 0.61
86 -22.08 17.92 16.50 1.619 0.5228 0.59 246 17.92 -22.08 30.85 1.577 0.5368 0.61
87 -22.45 17.55 16.64 1.623 0.5217 0.59 247 17.55 -22.45 31.00 1.573 0.5382 0.61
88 -22.83 17.17 16.77 1.628 0.5206 0.59 248 17.17 -22.83 31.14 1.570 0.5397 0.61
89 -23.21 16.79 16.91 1.632 0.5196 0.59 249 16.79 -23.21 31.29 1.567 0.5412 0.62
90 -23.58 16.42 17.05 1.637 0.5186 0.59 250 16.42 -23.58 31.44 1.564 0.5428 0.62
91 -23.96 16.04 17.18 1.641 0.5176 0.59 251 16.04 -23.96 31.59 1.561 0.5443 0.62
92 -24.34 15.66 17.32 1.646 0.5166 0.59 252 15.66 -24.34 31.74 1.558 0.5459 0.62
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93 -24.72 15.28 17.45 1.651 0.5157 0.59 253 15.28 -24.72 31.89 1.555 0.5476 0.62

94 -25.09 14.91 17.59 1.656 0.5147 0.59 254 14.91 -25.09 32.04 1.552 0.5493 0.63
95 -25.47 14.53 17.72 1.662 0.5138 0.59 255 14.53 -25.47 32.19 1.550 0.551 0.63
96 -25.85 14.15 17.85 1.667 0.513 0.59 256 14.15 -25.85 32.35 1.547 0.5527 0.63
97 -26.23 13.77 17.99 1.672 0.5121 0.59 257 13.77 -26.23 32.50 1.544 0.5545 0.64
98 -26.60 13.40 18.12 1.678 0.5113 0.59 258 13.40 -26.60 32.66 1.542 0.5563 0.64
99 -26.98 13.02 18.25 1.683 0.5105 0.59 259 13.02 -26.98 32.82 1.540 0.5582 0.64
100 -27.36 12.64 18.38 1.689 0.5098 0.59 260 12.64 -27.36 32.97 1.537 0.5601 0.65
101 -27.74 12.26 18.51 1.695 0.509 0.59 261 12.26 -27.74 33.13 1.535 0.562 0.65
102 -28.11 11.89 18.64 1.701 0.5083 0.59 262 11.89 -28.11 33.29 1.533 0.564 0.65
103 -28.49 11.51 18.77 1.707 0.5076 0.59 263 11.51 -28.49 33.46 1.531 0.566 0.66
104 -28.87 11.13 18.90 1.713 0.507 0.59 264 11.13 -28.87 33.62 1.529 0.568 0.66
105 -29.25 10.75 19.03 1.719 0.5063 0.59 265 10.75 -29.25 33.78 1.527 0.5701 0.67
106 -29.62 10.38 19.16 1.726 0.5057 0.59 266 10.38 -29.62 33.95 1.525 0.5722 0.67
107 -30.00 10.00 19.29 1.732 0.5051 0.59 267 10.00 -30.00 34.11 1.523 0.5744 0.67
108 -30.38 9.62 19.42 1.739 0.5045 0.59 268 9.62 -30.38 34.28 1.521 0.5766 0.68
109 -30.75 9.25 19.55 1.745 0.504 0.59 269 9.25 -30.75 34.45 1.520 0.5788 0.68
110 -31.13 8.87 19.68 1.752 0.5034 0.60 270 8.87 -31.13 34.62 1.518 0.5811 0.69
111 -31.51 8.49 19.81 1.759 0.5029 0.60 271 8.49 -31.51 34.79 1.517 0.5834 0.69
112 -31.89 8.11 19.93 1.767 0.5024 0.60 272 8.11 -31.89 34.96 1.515 0.5858 0.70
113 -32.26 7.74 20.06 1.774 0.502 0.60 273 7.74 -32.26 35.14 1.514 0.5882 0.70
114 -32.64 7.36 20.19 1.781 0.5015 0.60 274 7.36 -32.64 35.31 1.512 0.5907 0.71
115 -33.02 6.98 20.32 1.789 0.5011 0.60 275 6.98 -33.02 35.49 1.511 0.5932 0.71
116 -33.40 6.60 20.44 1.797 0.5007 0.60 276 6.60 -33.40 35.67 1.510 0.5958 0.72
117 -33.77 6.23 20.57 1.805 0.5004 0.61 277 6.23 -33.77 35.85 1.509 0.5984 0.72
118 -34.15 5.85 20.70 1.813 0.5 0.61 278 5.85 -34.15 36.03 1.508 0.6011 0.73
119 -34.53 5.47 20.82 1.821 0.4997 0.61 279 5.47 -34.53 36.22 1.507 0.6038 0.74
120 -34.91 5.09 20.95 1.829 0.4994 0.61 280 5.09 -34.91 36.40 1.506 0.6065 0.74
121 -35.28 4.72 21.08 1.838 0.4991 0.61 281 4.72 -35.28 36.59 1.505 0.6094 0.75
122 -35.66 4.34 21.20 1.846 0.4988 0.62 282 4.34 -35.66 36.78 1.504 0.6122 0.76
123 -36.04 3.96 21.33 1.855 0.4986 0.62 283 3.96 -36.04 36.97 1.504 0.6151 0.76
124 -36.42 3.58 21.45 1.864 0.4984 0.62 284 3.58 -36.42 37.16 1.503 0.6181 0.77
125 -36.79 3.21 21.58 1.873 0.4982 0.62 285 3.21 -36.79 37.35 1.502 0.6211 0.78
126 -37.17 2.83 21.70 1.882 0.498 0.63 286 2.83 -37.17 37.55 1.502 0.6242 0.78
127 -37.55 2.45 21.83 1.892 0.4979 0.63 287 2.45 -37.55 37.75 1.501 0.6274 0.79
128 -37.92 2.08 21.95 1.902 0.4977 0.63 288 2.08 -37.92 37.95 1.501 0.6306 0.80
129 -38.30 1.70 22.08 1.911 0.4976 0.63 289 1.70 -38.30 38.15 1.501 0.6339 0.81
130 -38.68 1.32 22.21 1.921 0.4976 0.64 290 1.32 -38.68 38.35 1.500 0.6372 0.82
131 -39.06 0.94 22.33 1.932 0.4975 0.64 291 0.94 -39.06 38.56 1.500 0.6406 0.83
132 -39.43 0.57 22.46 1.942 0.4974 0.64 292 0.57 -39.43 38.77 1.500 0.644 0.83
133 -39.81 0.19 22.58 1.953 0.4974 0.65 293 0.19 -39.81 38.98 1.500 0.6475 0.84
134 -40.19 -0.19 22.71 1.964 0.4974 0.65 294 -0.19 -40.19 39.19 1.500 0.6511 0.85
135 -40.57 -0.57 22.83 1.975 0.4974 0.65 295 -0.57 -40.57 39.41 1.500 0.6548 0.86
136 -40.94 -0.94 22.96 1.986 0.4975 0.66 296 -0.94 -40.94 39.63 1.500 0.6585 0.87
137 -41.32 -1.32 23.08 1.997 0.4976 0.66 297 -1.32 -41.32 39.85 1.500 0.6623 0.88
138 -41.70 -1.70 23.21 2.009 0.4976 0.67 298 -1.70 -41.70 40.07 1.501 0.6662 0.89
139 -42.08 -2.08 23.33 2.021 0.4977 0.67 299 -2.08 -42.08 40.30 1.501 0.6701 0.90
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140 -42.45 -2.45 23.46 2.033 0.4979 0.68 300 -2.45 -42.45 40.52 1.501 0.6742 0.91

141 -42.83 -2.83 23.58 2.045 0.498 0.68 301 -2.83 -42.83 40.76 1.502 0.6783 0.93
142 -43.21 -3.21 23.71 2.058 0.4982 0.68 302 -3.21 -43.21 40.99 1.502 0.6824 0.94
143 -43.58 -3.58 23.83 2.071 0.4984 0.69 303 -3.58 -43.58 41.23 1.503 0.6867 0.95
144 -43.96 -3.96 23.96 2.084 0.4986 0.69 304 -3.96 -43.96 41.47 1.504 0.6911 0.96
145 -44.34 -4.34 24.09 2.097 0.4988 0.70 305 -4.34 -44.34 41.71 1.504 0.6955 0.98
146 -44.72 -4.72 24.21 2.111 0.4991 0.70 306 -4.72 -44.72 41.96 1.505 0.7 0.99
147 -45.09 -5.09 24.34 2.125 0.4994 0.71 307 -5.09 -45.09 42.21 1.506 0.7046 1.00
148 -45.47 -5.47 24.46 2.139 0.4997 0.72 308 -5.47 -45.47 42.46 1.507 0.7093 1.02
149 -45.85 -5.85 24.59 2.153 0.5 0.72 309 -5.85 -45.85 42.71 1.508 0.7141 1.03
150 -46.23 -6.23 24.72 2.168 0.5004 0.73 310 -6.23 -46.23 42.97 1.509 0.719 1.05
151 -46.60 -6.60 24.84 2.183 0.5007 0.73 311 -6.60 -46.60 43.24 1.510 0.724 1.06
152 -46.98 -6.98 24.97 2.199 0.5011 0.74 312 -6.98 -46.98 43.50 1.511 0.7291 1.08
153 -47.36 -7.36 25.10 2.214 0.5015 0.75 313 -7.36 -47.36 43.78 1.512 0.7343 1.09
154 -47.74 -7.74 25.22 2.230 0.502 0.75 314 -7.74 -47.74 44.05 1.514 0.7396 1.11
155 -48.11 -8.11 25.35 2.247 0.5024 0.76 315 -8.11 -48.11 44.33 1.515 0.745 1.13
156 -48.49 -8.49 25.48 2.263 0.5029 0.77 316 -8.49 -48.49 44.61 1.517 0.7505 1.15
157 -48.87 -8.87 25.61 2.280 0.5034 0.77 317 -8.87 -48.87 44.90 1.518 0.7562 1.16
158 -49.25 -9.25 25.74 2.298 0.504 0.78 318 -9.25 -49.25 45.19 1.520 0.762 1.18
159 -49.62 -9.62 25.86 2.315 0.5045 0.79 319 -9.62 -49.62 45.49 1.521 0.7678 1.20
160 -50.00 -10.00 25.99 2.334 0.5051 0.80 320 -10.00 -50.00 45.79 1.523 0.7738 1.22



Vessel:

Date: 6/6/2007 Dn: 157
Personnel:

PCS Serial # 2171

IP Address:

POS controller Version (Use Menu Help > About) 3.1.0.1

POS Version (Use Menu View > Statistics) MV320 Ver4 
GPS Receivers

Primary Receiver
Secondary Receiver

Location: D M S
Approximate Position: Lat 43 3 57.63

Lon 70 40 53.85

DGPS

Satellite Constellation (Use View> GPS Data)
Primary GPS (Port Antenna)

HDOP: 0.924
VDOP: 1.178

Sattelites in Use: 10

PDOP 1.197 (Use View> GAMS Solution)

Note: Secondary GPS satellite constellation and number of satellites were exactly the same as the Primary GPS

POS/MV Calibration Report
Field Unit:GROUP 1

SYSTEM INFORMATION
R/V COASTAL SURVEYOR

MORGAN, YAZID, GIANELLA, BUGUCKI

192.168.0.50

SN4452A44285
SN 4447A44091

CALIBRATION AREA
South Gerrish Island

6,7,8,9,10,18,21,24,26,29

Fixed RTK



Settings
Gams Parameter Setup (Use Settings > Installation > GAMS Intallation)

User Entries, Pre-Calibration Baseline Vector
2.198 Two Antenna Separation (m) 0 X Component (m)
0.50 Heading Calibration Threshold 0 YComponent (m)

0 Heading Correction 0 Z Component (m)

Calibration Procedure:

Start time: 14:30
End time:
Heading accuracy achieved for calibration: 0.047

Calibration Results:
Gams Parameter Setup (Use Settings > Installation > GAMS Intallation)

POS/MV Post-Calibration Values Baseline Vector
2.198 Two Antenna Separation (m) 0.043 X Component (m)
0.500 Heading Calibration Threshold 2.19 YComponent (m)

0 Heading Correction -0.023 Z Component (m)

YES
YES

Save POS Settings on PC (Use File > Store POS Settings on PC)
File Name:

POS/MV CONFIGURATION

Configuration Notes:

POS/MV CALIBRATION

(Refer to POS MV V3 Installation and Operation Guide, 4-25)

GAMS Status Online?
Save Settings?

Calibration Notes: GAMS Ready Offline in ~5min by doing tight figure eights.

POS_Settings_157.nvm



The POS/MV uses a Right-Hand Orthogonal Reference System
The right-hand orthogonal system defines the following:
• The x-axis is in the fore-aft direction in the appropriate reference frame.
• The y-axis is perpendicular to the x-axis and points towards the

right (starboard) side in the appropriate reference frame.
• The z-axis points downwards in the appropriate reference frame.

The POS/MV uses a Tate-Bryant Rotation Sequence
Apply the rotation in the following order to bring the two frames of reference 

into complete alignment:
a) Heading rotation - apply a right-hand screw rotation ?z about the

z-axis to align one frame with the other.
b) Pitch rotation - apply a right-hand screw rotation ?y about the

once-rotated y-axis to align one frame with the other.
c) Roll rotation - apply a right-hand screw rotation ?x about the

twice-rotated x-axis to align one frame with the other.

GENERAL GUIDANCE

SETTINGS (insert screen grabs)
Input/Output Ports  (Use Settings > Input/Output Ports)

NOTE: COM3 and Analog are not used.



Heave Filter (Use Settings > Heave) Events  (Use Settings > Events)

Time Sync  (Use Settings > Time Sync)

Installation  (Use Settings > Installation)



Tags, Multipath and Auto Start (Use Settings > Installation > Tags, Multipath and Auto Start)

Sensor Mounting  (Use Settings > Installation > Sensor Mounting)



User Parameter Accuracy  (Use Settings > Installation > User Accuracy)

Frame Control (Use Tools > Config)

GPS  Receiver Configuration  (Use Settings> Installation> GPS Receiver Configuration)

Primary GPS  Receiver

Secondary GPS Receiver



Line Number Heading Speed

0002 225 6.0

0003 045 5.8

0004 225 5.9

0005 045 6.1

0006 045 5.9

0007 045 6.5

0008 019 3.5

0009 199 4.3

DATA ACQUISITION INFORMATION

Sonar Serial Number: Port head: 481. Starboard head: 322

Processing Unit Serial Number: kongsberg HWS 10 SN: 230

Sonar Mounting Configuration:  pole mount on the bow of the vessel

VESSEL INFORMATION

Description of Positioning System: Pos MV Applanix: SN 2171

Date of Most Recent Positioning System Calibration: 06/06/2007

Date of Most Recent EED / Factory Checkout: Unknown

Date of Current Vessel Offset Measurement / Verification: Unknown

Locality: Gulf of Maine,

Sub-Locality: Odiorne Point

Bottom Type: Rocky, sandy

Approximate Average Water Depth: 16 meters

Test Date(s) / DN(s):  06/06/2007

System Operator(s): R. Bogucki

Wind / Seas / Sky: 4 knots / seastate 1 / clear sky

TEST INFORMATION

MULTIBEAM SYSTEM INFORMATION

Multibeam Echosounder Calibration

System Location: Bow mounting
Multibeam Echosounder System: Kongsberg EM3002D 

Field Unit: Group 1 
Date of Test: 06/06/2007

Calibrating Hydrographer(s): L. Morgan, R. Bogucki, M. Yazid, J. Gianella
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0010 019 7.8

0011 199 7.8

0012 199 7.5

0013 019 5.7

0014 199 5.9

0015 283 5.0

0016 103 6.0

0017 283 5.0

0018 103 5.8

0019 283 5.8

0020 103 6.0

0021 283 6.0

0022 103 6.3

0023 283 5.4

0024 103 5.4

0025 283 5.4

0026 103 5.4
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Pitch Bias:  Head #1 (port): 1.81     Head #2 (starboard): 1.29

Navigation Timing Error:  0.11 seconds

Pitch Timing Error:

TEST RESULTS

Resulting CARIS HIPS HVF File Name:   CoastalSurveyor_EM3002D_2007.hvf

NARRATIVE
Timing: lines 0008 to 0014 were used to calculate timing, in three set of a pair of lines, the sets 
were 0008 and 0010, 0009 and 0012 (0011 was ruled out) and 0013 with 0014. The lines ran over a 
slope bottom. Pitch: the same lines 0008 to 0014 were used to calculate pitch in three set of a pair 
of lines, the sets were 0008 and 0009, 0010 and 0012 (0011 was ruled out) and 0013 with 0014. 
From line 0015 to 0026 lines were ran to obtain a single feature that permit solve heading bias. 
Roll: lines 0002 to 0007 were used to solve roll bias in both transducers, two set of three lines each 
were used to solve both heads. the first set were lines 0002, 0003 and 0005, and the second set 
were lines 0004, 0006 and 0007. In both cases, the comparison was done transducer by 
transducer. The sea bottom used was flat and the distance between lines were 70 m. After the data 
was posted in the server, all members of the group calculated their own values and after a 
meeting, the final values were defined.

Roll Timing Error:

Roll Bias:  Head #1 (port): -0.99     Head #2 (starboard): -1.60

Heading Bias:   Head #1 (port): -0.58     Head #2 (starboard): 0.01

Page 3 of 3



#// Database Parameters

#// Seafloor Information System
#// Kongsberg Maritime AS
#// Saved:  2007.06.14 13:05:28

#// Build info:
#* SIS:                 [Version: 3.4.1, Build: 112, CD generated: Tue May  1 07:21:42 2007]
[Fox ver = 1.4.34]
[db ver = 13, proc = 13.0]
[OTL = 4.0.118]
[ACE ver = 5.4.10]
[Coin ver = 2.4.4]
[Simage ver = 1.6.2a]
[Dime ver = DIME v0.9]
[STLPort ver = 461]
[FreeType ver = 2.1.9]
[TIFF ver = 3.8.2]
[GeoTIFF ver = 1230]
[GridEngine ver = ???]

#* Language             [3] #// Current language, 1-Norwegian, 2-German,3-English, 4-Spanish

#* Type                 [3020]
#* Serial no.           [322]
#* Number of heads      [2]
#* System descriptor    [33554432] #// 02000000 

#// *********************************************************************
#// Installation parameters

#{ Input Setup #// All Input setup parameters

   #{ COM1 #// Link settings.

      #{ Com. settings #// Serial line parameter settings.
         #* Baud rate:           [9600]
         #* Data bits            [8]
         #* Stop bits:           [1]
         #* Parity:              [NONE]
      #} Com. settings

      #{ Position #// Position input settings.
         #* None                 [1] [0] 
         #* GGK                  [1] [1] 
         #* GGA                  [1] [0] 
         #* GGA_RTK              [1] [0] 
         #* SIMRAD90             [1] [0] 
      #} Position

      #{ Input Formats #// Format input settings.



         #* Attitude             [0] [0] 
         #* ZDA Clock            [1] [1] 
         #* HDT Heading          [1] [0] 
         #* SKR82 Heading        [0] [0] 
         #* DBS Depth            [1] [0] 
         #* DBT Depth            [1] [0] 
         #* EA500 Depth          [0] [0] 
         #* ROV. depth           [1] [0] 
         #* Height, special purp [1] [0] 
      #} Input Formats

   #} COM1

   #{ COM2 #// Link settings.

      #{ Com. settings #// Serial line parameter settings.
         #* Baud rate:           [19200]
         #* Data bits            [8]
         #* Stop bits:           [1]
         #* Parity:              [NONE]
      #} Com. settings

      #{ Position #// Position input settings.
         #* None                 [0] [1] 
         #* GGK                  [0] [0] 
         #* GGA                  [0] [0] 
         #* GGA_RTK              [0] [0] 
         #* SIMRAD90             [0] [0] 
      #} Position

      #{ Input Formats #// Format input settings.
         #* Attitude             [1] [1] 
         #* ZDA Clock            [0] [0] 
         #* HDT Heading          [0] [0] 
         #* SKR82 Heading        [0] [0] 
         #* DBS Depth            [0] [0] 
         #* DBT Depth            [0] [0] 
         #* EA500 Depth          [0] [0] 
         #* ROV. depth           [0] [0] 
         #* Height, special purp [0] [0] 
      #} Input Formats

   #} COM2

   #{ COM3 #// Link settings.

      #{ Com. settings #// Serial line parameter settings.
         #* Baud rate:           [9600]
         #* Data bits            [8]
         #* Stop bits:           [1]
         #* Parity:              [NONE]
      #} Com. settings



      #{ Position #// Position input settings.
         #* None                 [1] [1] 
         #* GGK                  [1] [0] 
         #* GGA                  [1] [0] 
         #* GGA_RTK              [1] [0] 
         #* SIMRAD90             [1] [0] 
      #} Position

      #{ Input Formats #// Format input settings.
         #* Attitude             [1] [0] 
         #* ZDA Clock            [0] [0] 
         #* HDT Heading          [1] [0] 
         #* SKR82 Heading        [1] [0] 
         #* DBS Depth            [1] [0] 
         #* DBT Depth            [1] [0] 
         #* EA500 Depth          [0] [0] 
         #* ROV. depth           [1] [0] 
         #* Height, special purp [1] [0] 
      #} Input Formats

   #} COM3

   #{ COM4 #// Link settings.

      #{ Com. settings #// Serial line parameter settings.
         #* Baud rate:           [9600]
         #* Data bits            [8]
         #* Stop bits:           [1]
         #* Parity:              [NONE]
      #} Com. settings

      #{ Position #// Position input settings.
         #* None                 [1] [1] 
         #* GGK                  [0] [0] 
         #* GGA                  [0] [0] 
         #* GGA_RTK              [0] [0] 
         #* SIMRAD90             [0] [0] 
      #} Position

      #{ Input Formats #// Format input settings.
         #* Attitude             [0] [0] 
         #* ZDA Clock            [0] [0] 
         #* HDT Heading          [1] [0] 
         #* SKR82 Heading        [1] [0] 
         #* DBS Depth            [1] [0] 
         #* DBT Depth            [1] [0] 
         #* EA500 Depth          [0] [0] 
         #* ROV. depth           [1] [0] 
         #* Height, special purp [1] [0] 
      #} Input Formats



   #} COM4

   #{ UDP2 #// Link settings.

      #{ Com. settings #// Serial line parameter settings.
         #// N/A
      #} Com. settings

      #{ Position #// Position input settings.
         #* None                 [1] [0] 
         #* GGK                  [1] [1] 
         #* GGA                  [1] [0] 
         #* GGA_RTK              [1] [0] 
         #* SIMRAD90             [1] [0] 
      #} Position

      #{ Input Formats #// Format input settings.
         #* Attitude             [0] [0] 
         #* ZDA Clock            [0] [0] 
         #* HDT Heading          [0] [0] 
         #* SKR82 Heading        [0] [0] 
         #* DBS Depth            [0] [0] 
         #* DBT Depth            [0] [0] 
         #* EA500 Depth          [1] [0] 
         #* ROV. depth           [0] [0] 
         #* Height, special purp [0] [0] 
      #} Input Formats

   #} UDP2

   #{ UDP3 #// Link settings.

      #{ Com. settings #// Serial line parameter settings.
         #// N/A
      #} Com. settings

      #{ Position #// Position input settings.
         #* None                 [0] [1] 
         #* GGK                  [0] [0] 
         #* GGA                  [0] [0] 
         #* GGA_RTK              [0] [0] 
         #* SIMRAD90             [0] [0] 
      #} Position

      #{ Input Formats #// Format input settings.
         #* Attitude             [0] [0] 
         #* ZDA Clock            [0] [0] 
         #* HDT Heading          [1] [0] 
         #* SKR82 Heading        [0] [0] 
         #* DBS Depth            [1] [0] 
         #* DBT Depth            [1] [0] 
         #* EA500 Depth          [0] [0] 



         #* ROV. depth           [1] [0] 
         #* Height, special purp [1] [0] 
      #} Input Formats

   #} UDP3

   #{ UDP4 #// Link settings.

      #{ Com. settings #// Serial line parameter settings.
         #// N/A
      #} Com. settings

      #{ Position #// Position input settings.
         #* None                 [0] [1] 
         #* GGK                  [0] [0] 
         #* GGA                  [0] [0] 
         #* GGA_RTK              [0] [0] 
         #* SIMRAD90             [0] [0] 
      #} Position

      #{ Input Formats #// Format input settings.
         #* Attitude             [1] [0] 
         #* ZDA Clock            [0] [0] 
         #* HDT Heading          [1] [0] 
         #* SKR82 Heading        [0] [0] 
         #* DBS Depth            [1] [0] 
         #* DBT Depth            [1] [0] 
         #* EA500 Depth          [0] [0] 
         #* ROV. depth           [1] [0] 
         #* Height, special purp [1] [0] 
      #} Input Formats

   #} UDP4

   #{ Misc. #// Misc. input settings.
      #* External Trigger     [1] [0] 
   #} Misc.

#} Input Setup

#{ Output Setup #// All Output setup parameters

   #* PU broadcast enable  [1] [1] 

   #{ Host UDP1 #// System port (PU controll) Port: 16115

      #{ Datagram subscription on UDP port #// 
         #* Depth                [0] [0] 
         #* Raw range and beam a [0] [0] 
         #* Seabed Image         [0] [0] 
         #* Central Beams        [0] [0] 



         #* Position             [0] [0] 
         #* Attitude             [0] [0] 
         #* Heading              [0] [0] 
         #* Height               [0] [0] 
         #* Clock                [0] [0] 
         #* Single beam echosoun [0] [0] 
         #* Sound Speed Profile  [0] [1] 
         #* Runtime Parameters   [0] [1] 
         #* Installation Paramet [0] [1] 
         #* BIST Reply           [0] [1] 
         #* Status parameters    [0] [1] 
         #* PU Broadcast         [0] [0] 
         #* Stave Display        [0] [0] 
         #* Water Column         [0] [0] 
         #* Internal, Range Data [0] [0] 
         #* Internal, Scope Data [0] [0] 
      #} Datagram subscription on UDP port

   #} Host UDP1

   #{ Host UDP2 #// User controlled (Logging) Port: 16116

      #{ Datagram subscription on UDP port #// 
         #* Depth                [1] [1] 
         #* Raw range and beam a [1] [1] 
         #* Seabed Image         [1] [1] 
         #* Central Beams        [0] [0] 
         #* Position             [1] [1] 
         #* Attitude             [1] [1] 
         #* Heading              [1] [1] 
         #* Height               [1] [1] 
         #* Clock                [1] [1] 
         #* Single beam echosoun [1] [1] 
         #* Sound Speed Profile  [0] [1] 
         #* Runtime Parameters   [0] [1] 
         #* Installation Paramet [0] [1] 
         #* BIST Reply           [1] [1] 
         #* Status parameters    [0] [1] 
         #* PU Broadcast         [1] [0] 
         #* Stave Display        [0] [1] 
         #* Water Column         [0] [1] 
         #* Internal, Range Data [1] [0] 
         #* Internal, Scope Data [1] [0] 
      #} Datagram subscription on UDP port

   #} Host UDP2

   #{ Host UDP3 #// System port (Displays) Port: 16117

      #{ Datagram subscription on UDP port #// 



         #* Depth                [0] [1] 
         #* Raw range and beam a [0] [0] 
         #* Seabed Image         [0] [0] 
         #* Central Beams        [0] [0] 
         #* Position             [0] [0] 
         #* Attitude             [0] [1] 
         #* Heading              [0] [0] 
         #* Height               [0] [1] 
         #* Clock                [0] [0] 
         #* Single beam echosoun [0] [1] 
         #* Sound Speed Profile  [0] [1] 
         #* Runtime Parameters   [0] [0] 
         #* Installation Paramet [0] [1] 
         #* BIST Reply           [0] [0] 
         #* Status parameters    [0] [0] 
         #* PU Broadcast         [0] [0] 
         #* Stave Display        [0] [0] 
         #* Water Column         [0] [0] 
         #* Internal, Range Data [0] [0] 
         #* Internal, Scope Data [0] [1] 
      #} Datagram subscription on UDP port

   #} Host UDP3

   #{ Host UDP4 #// User controlled (Subscription) Port 16118

      #{ Datagram subscription on UDP port #// 
         #* Depth                [1] [0] 
         #* Raw range and beam a [1] [0] 
         #* Seabed Image         [1] [0] 
         #* Central Beams        [0] [0] 
         #* Position             [1] [0] 
         #* Attitude             [1] [0] 
         #* Heading              [1] [0] 
         #* Height               [1] [0] 
         #* Clock                [1] [0] 
         #* Single beam echosoun [1] [0] 
         #* Sound Speed Profile  [1] [0] 
         #* Runtime Parameters   [1] [0] 
         #* Installation Paramet [1] [0] 
         #* BIST Reply           [1] [0] 
         #* Status parameters    [1] [0] 
         #* PU Broadcast         [1] [0] 
         #* Stave Display        [1] [0] 
         #* Water Column         [1] [0] 
         #* Internal, Range Data [1] [0] 
         #* Internal, Scope Data [1] [0] 
      #} Datagram subscription on UDP port

   #} Host UDP4



#} Output Setup

#{ Clock Setup #// All Clock setup parameters

   #{ Clock #// All clock settings.
      #* Source:              [1] #// External ZDA Clock
      #* 1PPS Clock Synch.    [1] [1] 
      #* Offset (sec.):       [0]
   #} Clock

#} Clock Setup

#{ Settings #// Sensor setup parameters

   #{ Positioning System Settings #// Position related settings.

      #{ COM1 #// Positioning System Ports:
         #* P1T                  [0] #// System
         #* P1M                  [1] #// Enable position motion correction
         #* P1D                  [0] #// Position delay (sec.):
         #* P1G                  [WGS84] #// Datum:
      #} COM1

      #{ UDP2 #// Positioning System Ports:
         #* P3S                  [0] #// Ethernet
         #* P3T                  [0] #// System
         #* P3M                  [0] #// Enable position motion correction
         #* P3D                  [0.00] #// Position delay (sec.):
         #* P3G                  [WGS84] #// Datum:
      #} UDP2

   #} Positioning System Settings

   #{ Motion Sensor Settings #// Motion related settings.

      #{ COM2 #// Motion Sensor Ports:
         #* MRP                  [RP] #// Rotation (POSMV/MRU)
         #* MSD                  [0] #// Motion Delay (msec.):
         #* MAS                  [1.00] #// Motion Sensor Roll Scaling:
      #} COM2

   #} Motion Sensor Settings

   #{ Active Sensors #// 
      #* APS                  [0] [COM1] #// Position:
      #* ARO                  [2] [COM2] #// Motion:
      #* AHE                  [2] [COM2] #// Motion:
      #* AHS                  [2] [COM2] #// Heading:
   #} Active Sensors

#} Settings



#{ Locations #// All location parameters

   #{ Location offset (m) #// 

      #{ Pos, COM1: #// 
         #* P1X                  [0.00] #// Forward (X)
         #* P1Y                  [0.00] #// Starboard (Y)
         #* P1Z                  [0.00] #// Downward (Z)
      #} Pos, COM1:

      #{ Pos, COM3: #// 
         #* P2X                  [0.00] #// Forward (X)
         #* P2Y                  [0.00] #// Starboard (Y)
         #* P2Z                  [0.00] #// Downward (Z)
      #} Pos, COM3:

      #{ Pos, COM4/UDP2: #// 
         #* P3X                  [0.00] #// Forward (X)
         #* P3Y                  [0.00] #// Starboard (Y)
         #* P3Z                  [0.00] #// Downward (Z)
      #} Pos, COM4/UDP2:

      #{ Sonar head 1: #// 
         #* S1X                  [9.054] #// Forward (X)
         #* S1Y                  [-0.194] #// Starboard (Y)
         #* S1Z                  [1.456] #// Downward (Z)
      #} Sonar head 1:

      #{ Sonar head 2: #// 
         #* S2X                  [9.099] #// Forward (X)
         #* S2Y                  [0.248] #// Starboard (Y)
         #* S2Z                  [1.453] #// Downward (Z)
      #} Sonar head 2:

      #{ Attitude 1, COM2: #// 
         #* MSX                  [0.00] #// Forward (X)
         #* MSY                  [0.00] #// Starboard (Y)
         #* MSZ                  [0.00] #// Downward (Z)
      #} Attitude 1, COM2:

      #{ Attitude 2, COM3: #// 
         #* NSX                  [0.00] #// Forward (X)
         #* NSY                  [0.00] #// Starboard (Y)
         #* NSZ                  [0.00] #// Downward (Z)
      #} Attitude 2, COM3:

      #{ Waterline: #// 
         #* WLZ                  [0.509] #// Downward (Z)
      #} Waterline:

      #{ Depth Sensor: #// 
         #* DSX                  [0.00] #// Forward (X)



         #* DSY                  [0.00] #// Starboard (Y)
         #* DSZ                  [0.00] #// Downward (Z)
      #} Depth Sensor:

   #} Location offset (m)

#} Locations

#{ Angular Offsets #// All angular offset parameters

   #{ Offset angles (deg.) #// 

      #{ Sonar head 1: #// 
         #* S1R                  [40] #// Roll
         #* S1P                  [0.00] #// Pitch
         #* S1H                  [0.00] #// Heading
      #} Sonar head 1:

      #{ Sonar head 2: #// 
         #* S2R                  [-40] #// Roll
         #* S2P                  [0.00] #// Pitch
         #* S2H                  [0.00] #// Heading
      #} Sonar head 2:

      #{ Attitude 1, COM2: #// 
         #* MSR                  [0.00] #// Roll
         #* MSP                  [0.00] #// Pitch
         #* MSG                  [0.00] #// Heading
      #} Attitude 1, COM2:

      #{ Attitude 2, COM3: #// 
         #* NSR                  [0.00] #// Roll
         #* NSP                  [0.00] #// Pitch
         #* NSG                  [0.00] #// Heading
      #} Attitude 2, COM3:

      #{ Stand-alone Heading: #// 
         #* GCG                  [0.00] #// Heading
      #} Stand-alone Heading:

   #} Offset angles (deg.)

#} Angular Offsets

#{ ROV. Specific #// All ROV specific parameters

   #{ Depth/Pressure Sensor #// 
      #* DSF                  [1.00] #// Scaling:
      #* DSO                  [0.00] #// Offset:
      #* DSD                  [0.00] #// Delay:
      #* DSH                  [NI] #// Disable Heave Sensor
   #} Depth/Pressure Sensor



#} ROV. Specific

#{ System Parameters #// All system parameters

   #{ BS Offset and TX Freq. #// 

      #{ Sonar head 1: #// 
         #* GO1                  [0.0] #// BS Offset (dB)
         #* FX1                  [1] #// TX Freq. (kHz) 293
      #} Sonar head 1:

      #{ Sonar head 2: #// 
         #* GO2                  [0.0] #// BS Offset (dB)
         #* FX2                  [3] #// TX Freq. (kHz) 307
      #} Sonar head 2:

   #} BS Offset and TX Freq.

#} System Parameters

#// *********************************************************************
#// Runtime parameters

#{ Sounder Main #// 

   #{ Sector Coverage #// 

      #{ Sonar Head 1 angle (deg.): #// 
         #* MPA                  [60] #// Port
         #* MSA                  [10] #// Starboard
      #} Sonar Head 1 angle (deg.):
      #{ Sonar Head 2 angle (deg.): #// 
         #* MP2                  [10] #// Port
         #* MS2                  [60] #// Starboard
      #} Sonar Head 2 angle (deg.):
      #{ Coverage (m): #// 
         #* MPC                  [300] #// Port
         #* MSC                  [300] #// Starboard
      #} Coverage (m):

      #* ACM                  [0] #// Angular Coverage mode: MANUAL
      #* BSP                  [1] #// Beam Spacing: EQANGLE

   #} Sector Coverage

   #{ Depth Settings #// 
      #* FDE                  [0] #// Force Depth (m)
      #* MID                  [1.000] #// Min. Depth (m):
      #* MAD                  [50.000] #// Max. Depth (m):
   #} Depth Settings



   #{ Transmit Control #// 
      #* YPS                  [1] #// Pitch stabilization
      #* BMW [0] #// Beam Width: NORMAL
      #* TXA                  [0.0] #// Along Direction (deg.):
      #* PRF                  [40] #// Max. Ping Freq. (Hz):
   #} Transmit Control

#} Sounder Main

#{ Sound Speed #// 

   #{ Sound Speed at Transducer #// 
      #* Sound velocity probe [1] [0] 
      #* SHS                  [0] #// Source SENSOR
      #* SST                  [14847] #// Sound Speed (dm/sec.):
      #* Sensor Offset (m/sec [0.0] #// 
      #* Filter (sec.):       [2] #// 
   #} Sound Speed at Transducer

#// The ROV Specific parameters Offset and Scale is located in the Installation Parameters part of this l
#} Sound Speed

#{ Filter and Gains #// 

   #{ Filtering #// 
      #* SFS                  [2] #// Spike Filter Strength: MEDIUM
      #* RGS                  [1] #// Range Gate: NORMAL
   #} Filtering

   #{ Absorption Coefficient #// 
      #* ABC                  [70.134] #// 300.0 kHz
   #} Absorption Coefficient

   #{ Normal incidence sector #// 
      #* TCA                  [10] #// Angle from nadir (deg.):
   #} Normal incidence sector

#} Filter and Gains

#{ Data Cleaning #// 
   #* Used set:            [AUTOMATIC1] #// 
   #{ AUTOMATIC1 #// 
      #* PingProc.maxPingCountRadius                        [10]
      #* PingProc.radiusFactor                              [0.050000]
      #* PingProc.medianFactor                              [1.500000]
      #* PingProc.beamNumberRadius                          [3]
      #* PingProc.sufficientPointCount                      [40]
      #* PingProc.neighborhoodType                          [Elliptical]
      #* PingProc.timeRule.use                              [false]
      #* PingProc.overhangRule.use                          [false]



      #* PingProc.medianRule.use                            [false]
      #* PingProc.medianRule.depthFactor                    [0.050000]
      #* PingProc.medianRule.minPointCount                  [6]
      #* PingProc.quantileRule.use                          [false]
      #* PingProc.quantileRule.quantile                     [0.100000]
      #* PingProc.quantileRule.scaleFactor                  [6.000000]
      #* PingProc.quantileRule.minPointCount                [40]
      #* GridProc.minPoints                                 [8]
      #* GridProc.depthFactor                               [0.200000]
      #* GridProc.removeTooFewPoints                        [false]
      #* GridProc.surfaceFitting.surfaceDegree              [1]
      #* GridProc.surfaceFitting.tukeyConstant              [6.000000]
      #* GridProc.surfaceFitting.maxIteration               [10]
      #* GridProc.surfaceFitting.convCriterion              [0.010000]
      #* GridProc.surfaceDistanceDepthRule.use              [false]
      #* GridProc.surfaceDistanceDepthRule.depthFactor      [0.050000]
      #* GridProc.surfaceDistancePointRule.use              [false]
      #* GridProc.surfaceDistancePointRule.scaleFactor      [1.000000]
      #* GridProc.surfaceDistanceUnitRule.use               [false]
      #* GridProc.surfaceDistanceUnitRule.scaleFactor       [1.000000]
      #* GridProc.surfaceDistanceStDevRule.use              [false]
      #* GridProc.surfaceDistanceStDevRule.scaleFactor      [2.000000]
      #* GridProc.surfaceAngleRule.use                      [false]
      #* GridProc.surfaceAngleRule.minAngle                 [20.000000]
      #* GridProc.saveAllPings                              [false]
      #* SonarProc.use                                      [false]
      #* SonarProc.gridSizeFactor                           [4]
      #* SonarProc.mergerType                               [Average]
      #* SonarProc.interpolatorType                         [TopHat]
      #* SonarProc.interpolatorRadius                       [1]
      #* SonarProc.fillInOnly                               [true]
   #} AUTOMATIC1

   #{ Seabed Image Processing #// 
      #* Seabed Image Process [1] [0] 
   #} Seabed Image Processing
#} Data Cleaning

#{ Advanced param. #// 

   #{ Manual control #// 
      #* TPL                  [3] #// Pulse length (us) 150
      #* BAW [1] #// Bandwidth (kHz) 8
      #* RVF                  [0] #// Special TVG
      #* RV1                  [0.0] #// RX gain offset (dB)
      #* RV2                  [0.0] #// TVG ramp level (dB)
   #} Manual control

#} Advanced param.



 

 

 

APPENDIX III 

FEATURES REPORT 

(NO AWOIS ITEMS, DTONS, WRECKS, OR   

                MARITIME BOUNDARIES) 



APPROVAL PAGE 

W00275 

Data meet or exceed current specifications as certified by the OCS survey acceptance review 
process.  Descriptive Report and survey data except where noted are adequate to supersede prior 
surveys and nautical charts in the common area. 

The following products will be sent to NGDC for archive 
- W00275_DR.pdf 
- Collection of depth varied resolution BAGS 
- Processed survey data and records 
- W00275_GeoImage.pdf  

The survey evaluation and verification has been conducted according current OCS 
Specifications, and the survey has been approved for dissemination and usage of updating 
NOAA’s suite of nautical charts. 

Approved: ____________________________________________________________________ 
LT Matthew Jaskoski 
Chief, Atlantic Hydrographic Branch 
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